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Disclaimer
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This document contains proprietary information which is protected by copyright. All rights are
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gramming language without the prior written consent of Minisoft, Inc.
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License Agreement

READ CAREFULLY BEFORE INSTALLING THE MINISOFT SOFTWARE APPLICATION:

CUSTOMER: THE MINISOFT SOFTWARE APPLICATION (*PRODUCT"”) THATYOU PURCHASED CONTAINS COPYRIGHTS, TRADE SECRETS, TRADE MARKS, AND
OTHER INTELLECTUAL PROPERTY RIGHTS BELONGING TO MINISOFT, INC. ("MINISOFT"), HAVING ITS PRINCIPAL OFFICES LOCATED AT 1024 FIRST STREET,
SNOHOMISH, WASHINGTON, 98290, U.S.A. THE PRODUCT MAY BE INSTALLED, COPIED, DISPLAYED, EXECUTED, PERFORMED, OR USED IN ANY OTHER FASHION
ONLY IN ACCORDANCE WITHTHE TERMS OF THIS LICENSE AGREEMENT ("AGREEMENT” OR “LICENSE"). THE TERMS “YOU" OR "YOURS"” ARE SOMETIMES USED
HEREIN AND MEAN RESPECTIVELY CUSTOMER OR CUSTOMER'S.

SOMETIMES EACH OF MINISOFT AND CUSTOMER IS REFERRED TO HEREIN AS A “PARTY,” AND SOMETIMES THEY ARE COLLECTIVELY REFERRED TO AS THE
“PARTIES.”

YOU MAY NOT INSTALL, COPY, DISPLAY, EXECUTE, PERFORM OR USE IN ANY OTHER FASHION THE PRODUCT EXCEPT IN ACCORDANCE WITH THE TERMS AND
CONDITIONS OF THIS AGREEMENT. IFYOU INSTALL, COPY, DISPLAY, EXECUTE, PERFORM OR OTHERWISE USE ANY PART OF THE PRODUCT, YOU ARE DEEMED
TO HAVE ACCEPTED AND YOU ARE BOUND BY ALL THE TERMS AND CONDITIONS OF THIS MINISOFT LICENSE AGREEMENT ("AGREEMENT"). IN ORDER TO USE
THE PRODUCT, YOU MAY BE REQUIRED TO OBTAIN A UNIQUE CODE OR CODES FROM MINISOFT TO ENABLE INSTALLATION, COPYING, DISPLAY, EXECUTION,
PERFORMANCE AND OTHER USE OF THE SOFTWARE PRODUCT.

IFYOU DO NOT ACCEPT AND AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, YOU ARE PROHIBITED FROM INSTALLING, COPYING, DISPLAYING,
EXECUTING, PERFORMING, OR USING IN ANY OTHER FASHION THE PRODUCT. VIOLATION OF THIS AGREEMENT (1) CONSTITUTES INFRINGEMENT, MISAPPRO-
PRIATION AND CONVERSION OF MINISOFT’S COPYRIGHTS, TRADE SECRETS, AND OTHER INTELLECTUAL PROPERTY RIGHTS, (2) WILL SUBJECT THE INFRINGER
TO SIGNIFICANT CIVIL LIABILITIES FOR DAMAGES (INCLUDING WITHOUT LIMITATION STATUTORY DAMAGES) AND OTHER REMEDIES AND LIABILITIES, AND (3)
MAY CONSTITUTE VIOLATION OF CRIMINAL LAWS.

IFACUSTOMER IS PURCHASING AN UPGRADE FOR AN EARLIER VERSION OF THE PRODUCT, THEN THIS AGREEMENT SHALL SUPERSEDE THE TERMS AND CON-
DITIONS OF THE LICENSE AGREEMENT THAT APPLIED TO THE EARLIER VERSION AS TO THE USE OF THE UPGRADE PRODUCT AS OF THE DATE OF INSTALLATION
OF THE UPGRADE.

NOW, THEREFORE, in consideration of the foregoing provisions and the terms and conditions herein contained and for other good and valuable consideration, the
receipt and sufficiency of which are hereby acknowledged, the following terms and conditions apply:

A. License Grants

1. Upon MINISOFT's receipt from the Customer of the one-time license fee and further subject to the other terms and conditions herein, MINISOFT grants the Customer
anon-exclusive and non-transferable perpetual license: (a) to install and use the Product on only one host computer or business server in the Customer’s business
organization; and (b) to install the client portion of the Product on a network server for access by more than one personal computer and on any personal computer client
accessing the host server program.

2.You may not: (a) allow access to or use of the Product to anyone outside of your organization; (b) decompile, reverse engineer, decrypt, disassemble, or otherwise
attempt to copy or replicate the source code; (c) modify or translate those portions of the Product that are provided in an object or source code form, or alter, merge,
modify, reverse engineer or adapt the Product in any way including disassembling or decompiling; (d) copy, loan, rent, lease or sublicense, assign, convey, sell, mort-
gage, pledge, dispose or in any other manner transfer to a third-party any part of or all of the Customer’s rights and obligations under this Agreement or in the Product;
or (e) otherwise copy, distribute, rent, loan, disseminate, publish, sell or transfer any portion of the Product in any way inconsistent with or contrary to the terms and
conditions of the Agreement.

3. Any attempt to violate any prohibitions described in this Agreement shall be considered a material breach of this Agreement, and no attempt to violate section 2(c) or
2(d) in the immediately preceding paragraph shall have any effect, and any prohibited act described therein shall be void and of effect if made by the Customer.

4.You may make one copy of the Product for use as a backup copy (the “Copy”) provided that: (i) the Copy includes all notices of copyright and all other proprietary
rights appearing in and on the Software Product; (ii) the Copy and the original Product are not in use at the SAME time; (i) Customer establishes a procedure for ac-
counting for the Copy at all times; and (iv) Customer destroys or returns to MINISOFT the Copy when it is no longer required or when the license grants made hereunder
are terminated for any reason, whichever occurs first.

5. This Agreement grants to the Customer a license for use of the Product on the terms and conditions set forth in this Agreement; and (ii) the Customer may not install,
copy, perform, execute, display, or use in any other fashion the Product except in accordance with the terms and conditions of this Agreement. By any use of any ele-
ment of the Product, the Customer shall be deemed to have accepted and be bound by all the terms and conditions of this Agreement.

6. MINISOFT retains and reserves all rights to the Product. Nothing contained herein shall be deemed to convey to the Customer any title to, or an ownership interest
in, the Product or any of the intellectual property rights contained in the Product. Upon termination of this Agreement, all rights granted to the Customer herein shall
automatically revert to MINISOFT.

B. Termination

The license grants made hereunder shall automatically terminate on the date of any breach by the Customer of any of the terms and conditions of this Agreement. In
any such termination, you shall discontinue using the Product. You further agree to return the Product to MINISOFT or destroy all components of the Product and to
certify in writing that the Product is no longer in use and that you have kept no copies of the Product. In any such termination of the license grants, none of MINISOFT's
rights in law or equity shall be barred, discharged, released, or otherwise impaired by such termination, and MINISOFT reserves all such rights described herein.

C. Confidential Information

The Product also contains MINISOFT’s commercially valuable, proprietary and confidential information and trade secrets (collectively “Confidential Information”).

You are obligated to preserve and hold in confidence any Confidential Information and may not use any of it except in accordance with the terms and conditions of

this Agreement. Confidential Information shall not include what is already public at the date of its disclosure or what later becomes lawfully public through no fault or
responsibility of the Customer.

D. Limited Warranties and Limitations on Damages and Remedies.

1. Only the limited warranties expressly described in this section are made to the Customer purchasing this Product. No warranty of any kind, whether express or
implied, is made to any third-party or other transferee or successor of the Customer.

2. MINISOFT warrants that it has the right to grant the licenses contained in this Agreement.

3. MINISOFT warrants that this product will execute its programming instructions when properly installed on a properly configured computer for which it is intended.
MINISOFT makes no warranty of any kind, implied or express, that the Product will meet Customer’s requirements or that the Product will be uninterrupted or error-free
4. MINISOFT, Inc. warrants the media upon which this Product is recorded to be free from defects in materials and workmanship under normal use for a period of go
days from the date of purchase. During the warranty period MINISOFT will replace media that prove to be defective. Customer’s exclusive remedy for any media that
proves to be defective shall be to return the media to MINISOFT for replacement.

5. MINISOFT' only obligation, liability and/or remedy, with respect to the warranties set forth in this Agreement shall be one of the following, which MINISOFT shall
have sole discretion to choose: (1) as described above, to provide replacement media (whether in the form of the current release or otherwise) for the Product; (2) to



replace, without charge, the Product with a functionally equivalent software product; or (3) to refund the applicable license fees paid to MINISOFT by Customer. These
are the sole and exclusive remedies for any breach of warranty.

6. MINISOFT shall have no obligation, liability or any other kind of responsibility for the costs of restoring any destroyed or defective data, installation of replacement
media, or software conversion work made necessary by replacement media, even if MINISOFT had been specifically informed by Customer of the possibility or probabil-
ity of any such consequences. During the ninety (90) days warranty period for the media, MINISOFT will replace, without charge, on an exchange basis, any media which
is not as warranted. Customer must return the defective item postpaid to MINISOFT, postmarked within the time period stated above. Customer must either insure the
defective item being returned or assume the risk of loss or damage in transit. Any claim under the above warranty must include a copy of Customer’s receipt or invoice
or other proof of the date of delivery.

7.Year 2000 Warranty. MINISOFT warrants that the Product will accurately process date/time data (including, but not limited to, calculating, comparing, and sequenc-
ing) from, into, and between the twentieth and twenty-first centuries, and the years 1999 and 2000 and leap year calculations, in accordance with the Product’s docu-
mentation BUT ONLY to the extent that other technology and systems (e.g., software and operating systems, hardware and firmware) used in combination with the
Product properly exchanges date/time data with it. In addition to the limitations of liability and remedies described above in this Section, the Year 2000 warranty made
herein is made only for ninety (90) days after the date of delivery of the Product and only if any noncompliance is discovered and made known to MINISOFT in writing
within such ninety (90) days. The Year 2000 warranty expires after such ninety (g0) day period and shall not extend to any events occurring after the expiration date.

8. MINISOFT makes no other warranty, expressed or implied, with respect to the Product.

9. NOTICE: THE WARRANTIES, OBLIGATIONS AND LIABILITY OF MINISOFT AND THE RIGHTS AND REMEDIES OF CUSTOMER SPECIFICALLY SET FORTH INTHIS
AGREEMENT ARE THE CUSTOMER'S EXCLUSIVE REMEDIES. MINISOFT DISCLAIMS, AND CUSTOMER HEREBY WAIVES, DISCHARGES AND RELEASES MINISOFT,
ITS OFFICERS, DIRECTORS, EMPLOYEES AND AGENTS, FROM ANY AND ALL (1) OTHER WARRANTIES, OBLIGATIONS, OR LIABILITIES AND (2) RIGHTS, CLAIMS,
CAUSES OF ACTIONS, EXPRESS OR IMPLIED, ARISING BY LAW OR OTHERWISE IN CONNECTION WITH, REGARDING, OR ARISING FROM THE PRODUCT OR ANY
RELATED SOFTWARE, TANGIBLE OR INTANGIBLE ITEMS OR SERVICES PROVIDED UNDER THE AGREEMENT (INCLUDING, WITHOUT LIMITATION, ALL DOCU-
MENTATION SUPPLIED WITH THE PRODUCT). THE WAIVER, DISCHARGE AND RELEASE INCLUDE, BUT ARE NOT LIMITED TO: (1) ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A SPECIFIC PURPOSE; (2) ANY IMPLIED WARRANTY ARISING FROM COURSE OF PERFORMANCE, COURSE OF DEALING, OR
USAGE OF TRADE; AND (3) ANY OBLIGATION, LIABILITY, RIGHT, CLAIM, OR REMEDY, WHETHER IN TORT, CONTRACT, OR OTHERWISE. IN NO CASE SHALL MINI-
SOFT BE LIABLE FORANY INCIDENTAL, INDIRECT, SPECIAL, CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, LOSS OF USE, REVENUE, PROFIT,
OR DATA), PUNITIVE DAMAGES, EXEMPLARY OR OTHER STATUTORY DAMAGES, EXPENSES, COSTS (INCLUDING ATTORNEY FEES). INADDITION, IN NO CASE
SHALL MINISOFT'S LIABILITY EXCEED THE FEES PAID BY CUSTOMER FOR THE PRODUCT.

E.Updates

Customer is entitled to updates and enhancements to licensed software if under a current Minisoft software update and subscription service. The cost of the update and
subscription service will be 20% of the purchase price of the licensed software. The update and subscription service is for twelve (12) months and can be renewed at the
customer’s discretion.

F. Support Services

A customer that has purchased annual support entitles them to any and all software updates for their licensed product(s) as well as technical support via phone and
email. Software Updates are available from our web site, www.minisoft.com. Included with the purchase of support is the use of our Toll Free 80oo number, and support
email. Days and Hours of support coverage are Monday through Friday 7:30am (Pacific) until 5:00pm (Pacific). When support is purchased or renewed, an update may
be downloaded from the Minisoft Website. In cases where support has expired, back-support is charged to bring the support account current. Any supplemental soft-
ware code provided to you as part of the Support Services shall be considered part of the SOFTWARE PRODUCT and subject to the terms and conditions of this License
Agreement.

G. Miscellaneous

1. Governing Law. This Agreement is made for the sole benefit of the parties hereto, and there are no third party beneficiaries to this Agreement. This Agreement shall
be interpreted under the laws of the State of Washington, notwithstanding the application of any jurisdiction’s choice-of-law rules to the contrary.

2. Independent Contractors. No agency, partnership, joint venture, or employer-employee relationship is created hereby, and neither party nor any of its agents or
employees shall have any authority of any kind to bind the other party in any respect whatsoever. Each party is an independent contractor to the other party.

3. No Assignment by Customer. This Agreement shall be binding upon and inure to the benefit of MINISOFT and any successors and assigns. Customer shall have no
right to assign or otherwise transfer its rights or obligations under this Agreement except with the prior written consent of MINISOFT, which MINISOFT in its sole discre-
tion and for any reason or no reason provide or withhold.

4. Entire Agreement. This Agreement contains the complete understanding between the parties and shall as of the date the Product is first installed supersede all other
agreements, whether they are written or oral, between the parties concerning the particular subject matter. The language of this Agreement shall for all purposes be
construed as a whole, according to its fair meaning, not strictly for or against either party, and without regard to the identity or status of any person who drafted all or
any part of it. No purchase order or any other purchasing instruments issued by Customer, even if such purchase order or other purchasing instrument provides that

it takes precedence over any other agreement between the parties, shall be effective to contradict, modify, delete from or add to the terms of this agreement in any
manner whatsoever.

5. Severability. In the event that any one or more provisions of this Agreement is found by a court of competent jurisdiction to be unenforceable or invalid, then notwith-
standing any such finding the remainder of this Agreement shall remain in full force and effect, and such provision that is found to be unenforceable or invalid shall be
deemed severed.

6. Waiver. Neither party’s right to require performance of the other party’s obligations hereunder shall be affected by any previous waiver, forbearance, or course of
dealing, nor shall any waiver or forbearance or other course of dealing at any time with respect to any term or condition in this Agreement be effective unless evidenced
in writing signed by the waiving party as to such waiver, forbearance or other course of dealing. No waiver or modification of this Agreement or any covenant, condition
or limitation herein contained shall be valid and no evidence of waiver or modification shall be offered or received in evidence in any proceeding, arbitration or litigation
between the parties hereto arising out of or affecting this Agreement or the rights or obligations of the parties hereunder, unless such waiver or modification is in writing
duly signed by both parties.

7. Headings, Sections - The various headings in this Agreement are inserted for convenience only and shall not affect the meaning or interpretation of this Agreement or
any Section or provision hereof.

8. Disputes; jurisdiction and venue. Customer and MINISOFT consent to personal jurisdiction, subject matter jurisdiction, and venue in the state and/or federal courts
sitting in King or Snohomish Counties, State of Washington. Any action relating to this Agreement must be brought in the state or federal courts located in King or
Snohomish County, Washington.

9. Attorney’s Fees. In the event legal action is brought by either party to enforce any of the provisions of this Agreement, the prevailing party shall recover its reasonable
attorney’s fees, costs, and expenses, including but not limited to fees, costs and expenses of collecting any judgment.

10. Export. The export of this product is restricted by U.S. export regulations.

11. GOVERNMENT RESTRICTED RIGHTS. The Software Product and documentation are provided with restricted rights. Use, duplication or disclosure by the Govern-
ment is subject to restrictions as set forth in subparagraph (c) (2) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252. 227-7013 or subpara-
graphs (c) (1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Contractor/manufacturer is MINISOFT, INC., 1024
FIRST STREET, SNOHOMISH, WASHINGTON, 98290, U.S.A
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Main Menu Options

The Composer menu bar has the following six menus:
File, Project, Run, Host Tools, Window, and Help.

-
By Minisoft eFORMz Compaoser, Licensed to Minisoft

File Project Run HostTools Window Help

[=]#]

File Menu

The File Menu controls the project file with the following items:

Open Project
Opens any previously saved project template.

New Project
Creates a new project template with the supplied name.

Save Project
Saves the currently loaded project by its current name.

Save Project As
Saves the currently loaded project by a new user supplied name.

System Properties
Controls the operation of the eFORMz Composer.
Exit
Closes the currently loaded project and exits the Composer.

Project Menu

The Project Menu controls project items with the following options:

Add New Page to Project...
Adds a new page to your project. You will need to add a page for each logical page of
data within your report. Most projects will only contain one logical page regardless of
how many physical pages are contained within the report.



Add Form to Page...
Adds a form to a logical page. Adding multiple copies of the same form causes a
report to print multiple copies of a page of data.

Replace Form
Replaces an existing form with another. Used extensively when making alterations to
your form.

Reload Form
Reloads a previously imported RTF document automatically.

Remove Selected Item
Removes a selected page, form, or rule from the current project. A warning message
will be issued prior to the delete.

Properties...
Displays the Properties dialog box of the selected item in the Current Project window
(Project, Page, or Form).

Run Menu

Print
Sends a merged print file of your form and current data file to a selected printer.

Output..
PDF File
Produces a merged pdf file of your form and data output.
eFORMz Document Files
Produces an .efd file for eReader.

PCL Files (B/W)
Produces a merged file of your form and data in black/white pcl format.
PRN Files (B/W)
Produces a merged file of your form and data in black/white pcl format.

PCL Files (Color)
Produces a merged file of your form and data in color pcl format.

PostScript Files
Produces a merged file in the standard format for a Postscript printer.



XML

Produces a merged file in standard XML format for a Zebra printer.
HTML

Produces an HTML file of your output.

TEXT

Produces a print file in standard text format.

AFPDS

Produces an AFPDS print file.

ZPLII

Produces a print file in Zebra’s ZPLII format.

IPL

Produces a print file in Intermec Printer Language format.
TIFF, JPEG, PNG, GIF, BMP

Produces an image file in one of the above formats.

Process w/eDIRECT or eDIRECT PLUS
Processes output through eDIRECT.

Host Tools Menu

Local Director Toolkit
Provides a GUI interface for configuring the eFORMz job process on a Windows

operating system (Vista/7/Server 2008/8). For further information, see the eFORMz
Director Manual.

Install an extension
An eFORMz Extension is a file set that can be installed within an installed copy of
eFORMz that may be supplied to a customer by a Minisoft support representative.
The extension can include, files, directories and XML file modifications. These items
are scripted through an XML file.

AS400
Provides a GUI interface for configuring the eFORMz job process on your AS400. For
further information, see the eFORMz Director Manual.

Unix
Provides a GUI interface for installation, saving, uploading, and downloading files
from your Unix system. For further information, see the eFORMz Director Manual.



Window Menu

Help

The Window menu allows you to select which windows you would like to have active
within the eFORMz Composer.

Project
(default enabled) Displays the Current Project window.

Viewer
(default enabled) Displays the form and data Viewer window.

Variables
(default disabled) Displays the Variables viewer window.

Reset
Restores the default window settings.

Text to XML Editor
Works in conjunction with the Project Properties > Advanced Preprocessor > Text to
XML Converter.

Menu

eFORMz Manual
Provides quick access to the eFORMz pdf manual.

About Minisoft eFORMz
Displays the eFORMz copyright date and version number. Provides an activation
license check.

Available Character Sets
Contains a list of accessible character sets.
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System Properties

The eFORMz System Properties sets the settings for all projects. To access the eFORMz
System Properties, select System Properties from the eFORMz File Menu.

General Options

System Properties &J

l’GeneraI rViewer r Output r Logging

Default Project Path [WinisoftieFORMz_6\Projects L]

Default Data Path |\Minisoﬂ\eFORMz_B\F’rojeds | | |

["] Auto-save Project

EFZ Roll Count |0
MRU Count |4

Environment* | Metal = *requires Composer restart

to take effect
Show the following windows on Window|Reset:
Project window
[v] Viewer window

[] Variables window

OK | ‘ Cancel

Default Project Path
Sets the default folder that will be opened when retrieving a project file.

Default Data Path
Sets the default folder that will be opened when retrieving a data file.

Auto-save Project
Automatically saves changes made to your project file.

EFZ Roll Count

Permits the automated backup of projects based on a preset counter. For using the
EFZ Roll Count, consult the following tutorial:
http://support.minisoft.com/index.php/revision-handling}

6 System Properties
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MRU Count

Controls the number of recently-used projects to be shown from the File tab of the
eFORMz Composer Main Menu, based on a preset counter. For using the MRU Count,
consult the following tutorial:

http://support.minisoft.com/index.php/mru-count/

Environment

Changes the appearance of the eFORMz application. Shutting down the eFORMz ap-
plication is required for an appearance to change. Options include: Metal, CDE/Motif,
Windows Classic. Default is Metal.

Window|Reset
When checked, the associated window will appear if the Window Reset is selected
from the Composer Task bar.

o Project
° Viewer
o Variables

yiewer Options

System Properties M‘
General | Viewer rOutput rLogging |

Viewer Resolution Data Calor
60 dpi

90 dpi Constant Color

= Remove
140 dpi || -
160 dpi = HEIE IEEL Variable Color

Auto-load Viewer ™ Horiz. split pane Show offsettoolbars
Viewer label ) Vertical split pane Synchronize scrollbars

oK | ‘ Cancel

Viewer Resolution
(Default 120dpi) Controls the default zoom levels. Customize your viewer controls by
clicking Add or Remove.

System Properties 7
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Data Color
Allows you to change the data color displayed in the viewers.

Constant Color
Allows you to change the constant color displayed in the Form and Data Viewer.

Variable Color
Allows you to change the variable color displayed in the Data and Form Viewer.

Auto-load Viewer
When checked, the Form and Data Viewer automatically reloads when a change has
been made to the project rules, properties, or form.

Viewer label
When checked, it adds the labels Input and Output in the Form and Data Viewer. A
restart of the Composer is necessary to view the change.

Horizontal Split Pane
Allows you to view your input and output data simultaneously using the horizontal
split pane button. Default is checked.

Vertical Split Pane
Allows you to view your input and output data simultaneously using the vertical split
pane button.

Show Offset Toolbars
When checked, the Form and Data Toolbar displays allowing you to easily adjust the
positioning of your form and data. Default is checked.

Synchronized Scrollbars
Allows scroll bars within the Viewer to become synchronized. Default is checked.
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Output Options i
Systemn Properties u

(General r\riewer rOuiput r Logging

Default Output Path |\MinisoftieFORMz_E\Projects | | |

Automatically view eFORMz document output
Acrobat Reader| | | |

Automatically view PDF output

Compress PDF output

[_] Embed Fonts in PDF output

[] Qutput to XML in Verbose mode (default setting for new projects)

OK | ‘ Cancel

Default Output Path
Specifies the folder the output will be directed to.

Automatically view eFORMz document output
When checked, automatically starts the eReader when an .efd file is created.

Acrobat Reader
Path to the Adobe Acrobat reader executable. Specify if you wish to use a reader
other than system default.

Automatically View PDF Output
When checked, the PDF file reader will automatically start after a PDF file has been
built from eFORMz. Note: Path must be provided for Acrobat Reader.

Compress PDF Output
Compresses the eFORMz pdf file output allowing smaller file sizes.

Embed Fonts in PDF Output
Embedded fonts prevents font substitution when a pdf file is viewed or printed. Text
will remain in its original font.

System Properties 9
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Output to XML in Verbose mode

Default unchecked. When unchecked the XML output is condensed using token refer-
ences. Checked will cause the XML output to be represented in full text XML verbiage.

Logging Options

~
System Properties u

[ General | Viewer | Output | Logging

Log to standard output
[JLogtoFile []Append

File limit (bytes)

Roll Count

Resettime (interval) I:I:I
Resettime (value) I:I:I

Message Priority Fence

Log File I:I

| OK | ‘ Cancel

Log to Standard Output

When checked, logs all messages and standard output from eFORMz to a DOS win-

dow.

Log to File

When checked logs all messages and standard output from eFORMz to a text file.

Log file

When “Log to File” is checked use the Log File field to specify the path and file name

of the log file.

File limit (bytes)

Size in bytes of the log file where a new write will result in rolling. The action of
closing the current log file and opening a new log file is called “rolling” the log

file.

Roll Count
Limits the number of retained log files.

System Properties
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Reset time (interval)
The type of time interval that the reset time (value) uses. Options include: Years,
Months, Days and Hours. The default value is None.

Reset time (value)

The numeric value of reset time intervals to allow for the time a log file to reach
the maximum age before rolling. Options include: 1-5 Years, 2-12 Months, 1-30
Days and 1-24 Hours.

Append
Permits log messages to be appended to the log file.

Message Priority Fence
A message priority fence can filter what messages are displayed or written to the log

file.

0-3 - Allinformative messages

4-7 - Unused

8-11 - Status messages (i.e.: pages output, etc...) only

12-15 - Error and other high priority messages only

Minisoft recommends a log priority of 8. If the log priority is set below 8, it could
adversely affect performance.

eFORMz Viewer Options 11



Viewer Controls

Zoom Control
Controls the zoom level for viewing. The view setting will display to the right of your

zoom controller icons. To personalize your view settings, from the eFORMz Composer
File Menu select System Properties: Viewer tab > Zoom Control.

Vertical/Horizontal Panes

Allows you to customize your Viewer panes to view horizontally or vertically your
input and output data simultaneously. Use the Flip Pane button to switch the Viewer
windows. If you wish to view only one pane, slide the pane separator to one side.

[=]=]=]
(==}
o

Color Control
Enables/Disables color display in the Input Data Viewer and Form and Data Viewer.

i
L
Drag Control

Allows you to lock down movable elements in the Form and Data Viewer. Default is
unlocked.

[«]=]

Previous/Next Buttons
Allows you to move back and forth between data pages.

3406.0 1 1040.0

Row/Column Coordinates
The position of your mouse in the Form and Data Viewer. Coordinates based in de-
cipoints.
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Offset Adjustment Toolbars

‘D}%'%'Wo.n HE}%I%‘I?BA ||d|«|»|b|30.0 |i|1§|5.250 [T[o0 |
) 1]

sample_statement

When checked, the Form and Data Toolbar displays allowing you to easily adjust the
positioning of your form and data.

DAV

—1 11750 [ 4]«|mw|bfoo |

Form Offset Adjustment Toolbar

& |
& | F

1784 | q|«|®|>[300 |

Data Offset Adjustment Toolbar

—
Ml

Lines Per Inch - The number of data lines in every vertical inch.

Characters Per Inch - The number of characters per inch horizontally.
Used in conjunction with Fixed fonts.

[~

Height - The vertical height of each data character. Used in
conjunction with Proportional fonts.

-

Viewer Menu Options

The eFORMz Viewer has a main menu option that allows you to control different
aspects of the viewer such as the data grid, scrollbars, and viewer colors. Note some of
the options available in the following headings.

—
& Open Datal
ﬂ W Offset adjustment toolbars g‘ stmdata.dat 1 1812.0 :5094.0
[l Data color 3 =
Wariable color... -
. Constant color.. » =
¥ Synchronize scrollbars :
Dala Grid.. INC.
Output Grid... STREET
o WA 98250
ose
2-0200

T WAy Sen_RRm_gsnr

| 4T I ]
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Data, Variable, and Constant Color

Allows you to change the data color displayed in the Viewer.

r@. Data color @1
[ Swatches | HSV | HSL [RGB | CMYK |

Recent:

Preview
n - . Sample Text Sample Text .
. . . Sample Text Sample Text
| OK || Cancel H Reset |
Data Color

Allows you to change the data color displayed in the Viewer. Disable deactivates
the color function. Enable is the default.

Variable Color
Allows you to change the variable colors displayed in the Viewer.

Constant Color
Allows you to change the constant colors displayed in the Viewer. Disable
deactivates the color function. Enable is the default.
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Synchronize Scrollbars

When checked, scroll bars become synchronized in the Viewer windows.

Data Grid

Allows you to include/exclude the data grid from the Input Data Viewer. Customize the
data grid size using the horizontal and vertical decipoint values.

r Y
Adjust Grid %™

Show grid Snap selection to grid

Horizontal origin (0.0 Vertical origin |0.0
Horizontal size [72.0 Vertical size [120.0

Reset to form defaults |

| oK | ‘ Cancel ‘

Options Available:

Show Grid
Displays the data grid for easy character selection.

Snap Selection to Grid
Allows you to precisely align objects or data to the grid.

Horizontal/Vertical Origin
Sets the horizontal and/or vertical start of the grid. Values are in decipoints.

Horizontal/Vertical Size
Sets the horizontal and/or vertical size between each line of the grid. Values are in
decipoints.

Reset to Form Defaults
Sets origin of size to the default of the form.

eFORMz Viewer Options 15



I
SECTION 1

Output Grid

Allows you to include/exclude the output grid from the Form and Data Viewer.
Customize the data grid size using the horizontal and vertical decipoint values.

[ Adjust Gric =)

Show grid [ ] Snap selection to grid

Horizontal origin |0.0 Vertical origin [360.0
Horizontal size (71.3 Vertical size |115.2
Major grid increment |0

Resetto form defaults

)

| OK | ‘ Cancel ‘

Options Available:

Show Grid
Displays the data grid for easy character selection.

Snap Selection to Grid
Allows you to precisely align objects or data to the grid.

Horizontal/Vertical Origin
Sets the horizontal and/or vertical start of the grid. Values are in decipoints.

Horizontal/Vertical Size
Sets the horizontal and/or vertical size between each line of the grid. Values are
in decipoints.

Major Grid Increment
Controls the number of large increments contained in the grid.

Reset to Form Defaults
Sets origin of size to the default of the form.

Close Option
Closes the currently displayed tab in the Viewer.

16 eFORMz Viewer Options
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Variables Viewer

The eFORMz Variables Viewer window displays the details of each variable. The
information included pertains to:

¢ The name of the variable.

¢ The data contained within the variable.

The Variable column shows the name of the variable and the number of times it is
repeated.

The column to the right presents the data that the variable contains. Variables repeated
more than once occupy the corresponding number of lines.

Variables

Variable
ADDRESS(0) [Tom JoNES -
ADDRESS(1) l0z4 FIRST ETRE
ADDRESS(2) SHNOHOMISH, WA

AMOUNT(0) VioID VOID |

Variables Viewer Options 17
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Current Project Options

The Current Project window displays the entire project layout:

Project Name

Global Variables
Preprocessor(s)

Page(s)

Form(s)

Input and Constant Fields
Variables
Procedures/Actions
Rules

Form and Rule Conditions

® & 6 & 6 O o o o o o

Document Template

l & Project - sampstm

& [sampstm =
¢ B Sample Statement
¢ [d sample_statement
o [#] variables
45 CompanyName
[ Rules
¢ '8 Bold CompanyName
o [B] Actions
Flace Text

[4]

4] [*]
Project | eDIRECT PLUS

18 Current Project Options
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Project Properties
The Project Properties controls a project as a whole, for example:
¢ print orientation
¢ number of each individual copies
¢ and data parsing.

To access the Project Properties, select the project name from the Current Project
window, right click, and select Properties:

F hl
Project Properties u
1’ Printer Control | Sort | Notes | DataParsing | Advanced | Images | Databases | |»

@ All pages
Simplex.‘Duplex|Simplex |v| o
Current page
Top offset registration |0.0
Page range: _ From start
Left offset registration |0.0 o
From end
Copies |1
’_ Start page
Base macro |11
J End page
Perforation skip
Qutput to XML in Verbose mode
[] Exclude left and right unprintable edge in PDF output
OK | ‘ Cancel
L. Fl

Current Project Options 19



Printer Control Options

Media

Used to put logical output page(s) onto a physical page. Uses would be to arrange
logical pages n-up (2-up) on a physical page or to rotate a logical page on a physi-
cal page. When “"Media” is set to “"Default” the physical page is the same as the
logical page. “Media” entries are defined in eFORMzCfg.xml.

Simplex/Duplex
Simplex
Long-Edge Duplex
Short-Edge Duplex

Top Offset Registration
Sets the top margin position for printing (in decipoints).

Left Offset Registration
Sets the left margin position for printing (in decipoints).

Copies
Sets the number of copies printed for each physical page.

Base Macro
Specifies the macro ID number sent to the printer. Use when a printer contains
saved macro’s in print memory. Default is 11.

Perforation Skip

A setting often used with tractor-fed printers. Unchecked allows you to use the
maximum number of lines per page. Checked reduces the number of available
printed lines. Default is checked.

Output to XML Verbose Mode

Default unchecked. When unchecked the XML output is condensed using token
references. Checked will cause the XML output to be represented in full text XML
verbiage.

Exclude left and right unprintable edge in PDF output
Excludes the left and right margin from pdf file output.
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Print/Output - All Pages
When specified, the merge process will print all pages within a data file.

Print/Output - Current Pages
When specified, the current page being viewed within the eFORMz Viewer will be
printed.

Print/Output - Range of Pages
When selected, the Start Page and End Page fields will become available. Enter
the range of pages you would like to print.

Sort Options
e ~
Project Properties u
( Printer Control r Sort r Hotes r Data Parsing eranoed r Images r Databases r »
rSort keys
Form J,Ascending ‘ Mew ‘
‘ Edit ‘
‘ Remove ‘
‘ Move Up ‘
‘ Move Down ‘
‘ Change Order ‘
* gutput grouped by this key
Set Grou ‘
[]Input is in sorted order ‘ b
DK | ‘ Cancel

The Sort tab allows you to sort your data file based on a variable or form. Multiple
variables or forms can be added.

Cross-Reference: For sorting pages by data, view the following tutorial:

http://support.minisoft.com/index.php/adding-page-sort-to-an-eformz-project

Current Project Options 21
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Notes Options
( Project Properties g‘
r Printer Control r Sort r HNotes r Data Parsing eranoed r Images r Databases r »

~Motes

DK | ‘ Cancel

~

This section is available for documenting changes and providing a general explanation
of your process.

22 Current Project Options
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Data Parsing Options
Project Properties u

( Printer Control rSort r Notes r Data Parsing rhdvanoed r Images r Databases I’ 3 |

Line Termination: [ Translate CR to CRILF [_]| Translate LF to CRILF

[ ParserOptions | PCL | SCS |  AFPDS |

= o o oW

oK | ‘ Cancel

= e — ]

Line Termination:

Translate CR to CR/LF

When selected, a data file containing only carriage returns is translated into a data
file containing carriage returns and line feeds.

Translate LF to CR/LF
When selected, a data file containing only line feeds is translated into a data file con-
taining carriage returns and line feeds.

Parser Options
Specific parser options for the following data parsers: PCL, PDF, AFPDS, ZPLII,
eFORMz Document (.EFD), EPL2, IPL, RTF, SCS, XML, DPL and IPDS.

Current Project Options 23



More Print Stream options:
PCL
For use with a Printer Command Language data stream.

Processed Control Codes
Contains a listing of possible control codes in your data file.

Ignore (>>)
Moves a selected control code to the Ignore Control Codes list.

Process (<<)
Moves selected ignored control code to the Process Control Codes list.

Ignore all
Moves all control codes listed to the Ignore list.

Process all
Moves all ignored control codes to the Process Control Codes list.

Ignored Control Codes
Contains a listing of all ignored control codes.

Suppressed Symbol Sets
(Advanced feature) Allows Softfont symbol sets to be suppressed from the incoming
datastream.
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scs
For use with a System Network Architecture Character Stream, which contains SNA
character string controls.

Processed Control Codes
Contains a listing of possible control codes in your data file.

Ignore (>>)
Moves a selected control code to the Ignore Control Codes list.

Process (<<)
Moves selected ignored control code to the Process Control Codes list.

Ignore all
Moves all control codes listed to the Ignore list.

Process all
Moves all ignored control codes to the Process Control Codes list.

Ignored Control Codes
Contains a listing of all ignored control codes.

Current Project Options 25



AFPDS
For use with an Advanced Function Printing Data Stream.

Overlay library
For use with the 1ibrary-name parameter in printer files.

Use overlays
When checked, enables the use of the OVERLAY record-level keyword.

Page Segment library

For use with page segments that are printed as part of an overlay resource or as
part of the data through an Include Page Segment (IPS)structured field oran
Include Object (IOB)structured field.

Use page segments
When checked, enables the use of page segmentsvia Include Page Segment
or Include Object.

Overlay/Page Segment Adjustments
Moves the overlay or page segment by left and top offsets.
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Advanced Options
r N
Project Properties ﬂ
Data Parsing | Advanced | Images | Databases | Archives | XML Output | PDF.. 4|»
Image output type Image output resolution |96
Page Rulalian* * AFP and IPDS only
Primary component [ ] Extend pages
Minimum page number size |0

[] Load initial page number from a file

wumber file l:l

[] Update initial page number file after printingloutput

Initial

Authentication User Password |

| OK | | Cancel

Image output type
When outputting an image, select from Grayscale, Black and White and Color op-
tions for the image output type.

Image output resolution
The image resolution. Default is 6.

Page Rotation
Positions the page by degrees for Advanced Function Printing and Intelligent
Printer Data Stream applications only.

Primary component
For use with a composite data file. The <Component> tag is specified here in
conjunction with the Output from Project Rule Action.

Minimum page number size

Minimum number of characters for page number. If the number of digits of the
current page number is less then this value then it will be padded with leading
zeroes up to the minimum character size.
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Load initial page number from a file
Loads a page number from an external file.

Initial page number file
Specified path to the external page number file.

Update initial page number file after printing/output
Updates the page number file automatically after each process.

Authentication user/Password
Configure a username and password for the specific project file.

Images
( Project Properties ﬂ‘
Printer Control r Sort r Notes r Data Parsing rM\ranoed r‘— D 3

rilmages

oK | ‘ Cancel

L d

The Images dialog box allows you to import images (jpg, gif, bmp, tiff, pdf, prn) into
your project file to be used later in an action or variable. Note that all images added to a
project are saved in the output in case they are referenced on any of the pages.
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Databases Option
rPrcljed Properties ﬂ‘I

f Printer Control I/Sort r Notes r/ Data Parsing eranoed rlmages r/ Databases »
rD

* active in Composer

OK | ‘ Cancel

New
Allows you to configure and maintain database connections.

Note: The Driver Class and URL fields are case sensitive. To save the connection
information select Save to File to create a text file of your connection informa-

tion. When using the same database for a different project, click the Load from
File button to select the text file that was created earlier.

If the database cannot be read, a qualifying record cannot be found, or the value
of the column is NULL then the variable value will be set to the empty string.

For supported database driver and url path specifications, see Appendix B: Data-
base URL and Driver Classes.

Edit
Permits modifications to a database in the list.

Remove
Deletes a database entry from the list.
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Activate / Deactivate

Enable or disable connectivity to the selected database when viewed from the

Composer only.

Archives Option

Project Properties

Advanced | Images | Databases | Archives | XML Output | PDF Output | <

 Archives

New

Edit

Remove

| ‘ Cancel

L

d

The Archives tab works in conjunction with eDIRECT. The Archive can be configured
from within the project or externally in the Archives.xml file. This configuration file
consists of a name and a provider name and any other parameters specific to the

provider.

Current Project Options
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XML Output Option
( Project Properties u1
Advanced | Images | Databases | Archives | XML Output | PDF Output | EE

XML output root name | |

Namespace| |V|

[] Omit XML declaration

[] Omit project level root from output if possible

rName Spaces

New

Edit

Remove

OK | ‘ LCancel

a

The XML Output tab controls the name and namespace of a root element when doing
XML output. It controls whether the “<xml?” declaration is included. It also allows the

definition of namespaces. The namespaces can be specified on the root and any record
elements.

Cross-Reference: For more on generating XML output with eFORMz, consult the ‘
following: http://support.minisoft.com/index.php/record-element/

Current Project Options 31


http://support.minisoft.com/index.php/record-element/

B
SECTION 1

PDF Output Option

rProjecl Properties u1
Advanced | Images | Databases | Archives | XML Output | PDF Output 1

l/ Encryption r\u’iewer r Open Actions |

Encrypti0n|Nnne |v|

UserPassword| |

Owner Password | |

~Permissions

Allow Printing [ Allow Degraded Printing
[ Allow Modify Contents [ Allow Assembly

Allow Copy [ Allow Screen Readers

Allow Modify Annotations Allow Fill In

OK | ‘ Cancel

Encryption

Encrypt your PDF documents in one of the following ways:

Encryption

Options include Standard 4o0-bit, Standard 128-bit and AES 128-bit encryption.
Encryption is used to enforce restrictions on your document. The permissions
that can be granted or restricted depend on the strength of the encryption
(40-bit vs. 128-bit). If you are using 40-bit encryption, every permission that has
the remark 128-bit below is granted automatically. If you want to revoke these
permissions, you need to use 128-bit encryption.

User Password
Refers to the ‘open password'.

32 Current Project Options



Owner Password
Refers to the ‘permissions password".

The maximum password length is 32 characters. You may enter 32 characters or
more but only the first 32 characters will be taken into account. One or both of
the passwords fields can be empty. If a user password is not specified, all users
will be able to open the document without being prompted for a password, but
the permissions and restrictions (if any) will remain in place.

For a higher level of encryption for your document, choose 128-bit key length
and always set both passwords, using different strings and all 32 characters for
each one. If a password you choose is shorter than 32 characters, it will be pad-
ded with default padding.

Allow Printing
(Default checked) Printing the document.

Allow Degraded Printing
(128-bit) Printing the document, lesser quality printout than Allow Printing.

Allow Modify Contents
For example, changing page content, inserting or removing pages.

Allow Assembly
(128-bit) Inserting, removing, rotating pages and adding bookmarks are allowed.
Contents of a page cannot be changed, unless All Modify Content is allowed.

Allow Copy
(Default checked) Copying or extracting text and graphics from the document,
including technologies such as screen readers or other accessibility devices.

Allow Screen Readers
(128-bit) Extracting text and graphics from document using an accessibility
devices.

Allow Modify Annotations
(Default checked) Adding or modifying text annotations and interactive form
fields.
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AllowFill In
(Default checked) (128-bit) Filling form fields; adding or modifying annotations
only if Allow Modify Annotations is granted.

d hl
Project Properties g

[ Printer Control | Sort | Notes | Data Parsing | Advanced | Images | Databases | |[»

[ Encryption [ Viewer | Open Actions |

Page IayoutI:E

Page mode|Notset |v|

Show tool bar |Not set I~

Show menu bar|Notset |v|

Show window UI | Not set I~

Resize window to fit page|Notset |v|
Centerwindow|Notset |v|

Display documentﬁtle|Notset |v|
Print scaling [Not set I~
simplexDuplex [Not set I~

—

| OK | ‘ Cancel
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Viewer
Adjust the options for viewing the PDF document:

Page layout
The page layout to be used when the document is opened. Options include:

Single page - Display one page at a time (default).

One column - Display the pages in one column.

Two columns, odd on the left - Display the pages in two columns, with odd-
numbered pages on the left.

Two columns, odd on the right - Display the pages in two columns, with odd-num-
bered pages on the right.

Two pages, odd on the left - Display the pages two at a time, with odd-numbered
pages on the left.

Two pages, odd on the right - Display the pages two at a time, with odd-
numbered pages on the right.

Page mode
Sets how the document should be displayed when opened. Options include:

None - Neither document outline, nor thumbnail images visible (default).

Show Outlines - Document outline visible.

Show Thumbnails - Thumbnail images visible.

Full screen - Full-screen mode. No menu bar, window controls, or other windows
will be visible.

Show tool bar
Displays (or hides) the toolbar.

Show menu bar
Displays (or hides) the menu bar.

Show window Ul
Displays (or hides) the window user interface.

Resize window to fit page
Adjusts the window to fit the page.
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Center window
Centers the window.

Display document title
Displays the title of the PDF document.

Print scaling
The Default option scales the PDF to a printable area.

Simplex/Duplex
(Default checked) Adding or modifying text annotations and interactive form
fields.

AllowFill In
Printing options include Simplex, Short Edge Duplex, and Long Edge Duplex.
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i Bl
Project Properties u

[ Printer Control | Sort | Notes | DataParsing | Advanced | Images | Databases | |»

Encryption | Viewer | Open Actions |
@® None

) Execute a named action

MNamed action | |

) Execute Javascript

Javascript

OK | ‘ Cancel

Open Actions

Set an action to be performed at the opening of the document.

None
(Default) No action set.

Execute a named action
Options include:

Open print dialog - Opens the print dialog upon opening the PDF.

Go to first page - Displays the first page of the PDF upon opening.
Go to last page -Displays the last page of the PDF upon opening.

Execute Javascript
Enter a Javascript statement to execute an action.
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Preprocessors

Preprocessors parse incoming data in one of the following ways:

& Project - XML Sample

& XMLSampl
¢ [ Page1| Properties... »

Display Forms and Data...
¢ Jj‘ Open Data File...

T data
¢ [¥ Header

| Print... ¥ Logo = Minisoftjpg
Output... ¢ [JF ReturnAddress
: [ return_address_name :
ocess wieDIREC Us - -
Do 1 [0F return_address = 1024
Add Page... T [0F return_city_state_zip = ¢
Add Clobal Variable. [} labelTexts = Packing Slip:
il | — or
Add Preprocessor ¥ Macro Insert n
Add AMD Condition... ¥ Skip until a string is found r

Row - FROM & TO Replace occurrences of a string

Row: - SPACER ROW | Multiple replace occurrences of a string
Row: - ITEMS HEADER Command parsing —
Row: - ITEMS DETAILS =

Row - SPACER RO | Sedquential Line Marker

TYYeTYY
N

Row: - TOTALS Text file pagination
d | Il | | Flat File Parser
Project L eDIRECT PLUS Text to XML Converter
Variables S0L ResultSet
; Project
Variable

Logo Hinisofr. Character Set Translator
return_address_name Minizot e |Insertastring
return_address 1024 Fits petsuite
return_city_state_zi 3 h i zh

_CIt_ o no ?m Lz JetForm IFD File Parser
labelTextb Packing & I
I Al T AT [ RETRF. RFP L1 P I“ ‘ |

Macro Insert - Permits the insertion of a macro into the file.

Skip until a string is found - Ignores incoming string commands until the speci-
fied string is found. Specify the number of occurrences the specified string should
be skipped.

Replace occurrences of a string - Replaces a specified string with another.
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Multiple replace occurrences of a string - Replaces multiple strings with another.
Command parsing - For custom command parsing.
Sequential Line Marker - Marks incoming data based on a search criteria.

Text file pagination - Searches for a string in a particular column and then issues
aformfeed (\f) at the beginning of that line.

Flat file parser -
Ability to parse as input comma delimited or EDI formatted files.

Text to XML Converter -
Converts text files to XML.

Note: For Command File Processor Parameters and Preprocessor Data Parsing
Control Codes, see Appendix A: eFORMz Preprocessor. For more on the Text to
XML Converter, view the Text to XML Manual.

SQL ResultSet - The result set of an SQL statement is passed in XML format to
the next preprocessor or to the main project.

Project - Processes the data file with a project. The output of the project is
passed in efd format to the next preprocessor or to the main project.

Character Set Translator - Change from one character set to another.

Insert a string - Allows the insertion of a string at a particular byte location.
NetSuite - For use with retrieving NetSuite data.
JetForm IFD File Parser - For use with parsing IFD files.
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Page Properties

The Page Properties dialog box provides general information about your logical page.
To open the Page Properties dialog box, select a project page from the Current Project
window, right click, and select Properties:

( Page Properties §1
l/ Page Input rXML Input |

Lines per page 0| [~

*0 =use formfeed character
for page breaks

| OK | ‘ Cancel

Page Input:
Lines Per Page
Number of lines per each data page. Default settings:

Portrait = 66 Ipi
Landscape = 51 Ipi

*0=Use formfeed character for page breaks

Zero indicates that the data contains formfeeds. Page breaks will then be issued
when a form feed appears in the merge process.
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Page Properties lﬂ
[ Page Input [xMmeut |

Record Tag| |

Pagination method: ® by Tag count (' by grouping Tags

Pagination Tag| |

Tags per page |1

| OK | | Cancel |

XML Input
Define an XML data source.

Record Tag

The Record Tag is the name of the tag in the XML data file that represents a new
data page. The name is an absolute node name. If left blank the record tag will be
the root.

Pagination method
Define how pages are set. Default is by Tag count.

Pagination Tag and Tags Per Page

The Pagination Tag is the name of the tag to use for pagination. It is relative to
the Record Tag. Multiple occurrences of the named tag within the tag named by
the Record Tag will appear on separate data pages based upon the value of Tags
per page. If Pagination Tag is blank, no pagination takes place.

Form Properties

The Form Properties controls the placement of the form and data. To access the Form
Properties:

1. From the Current Project window select a project form, highlight Properties and
select General.

2. The Form Properties dialog box will display with multiple tabs including General,
Font, Data Relocation, Data Suppression, Zebra XML, HTML Output and Test Data.



B
SECTION 1

42

General Tab

[~ hl
Form Properties u

| General | Font | DataRelocation | Data Suppression | ZebraXML | |»

Page Size |Lmr |v| Farm Data
= Topofset|1750 | 1784 |
b

Orientation | Partrait

Lines perinch |6.250

Data viewer size:

Left offset|0.0 | o0 |

(8 Match page size
) Fixed Width Height

[ ] Exclude data [_| Overlay on previous form

eaporsiso[Ner || SourceTry[cumert <]
[ 1 Suppress output when empty  Qutput Tra].r

Edit condition oK Cancel

Page Size
Available options are Executive, Letter, Legal, Ledger, Letter - no margins, Legal
- no margins, Ledger - no margins, As, A4, A3, Monarch, Com-10, DL, C5, and Bs.

Note: For custom page dimension specification, user-specific specifications can
be added to the eFORMzCfg_User.xml file. For further information see Appendix
A: User Configuration Files.

Orientation
Available options are Portrait, Landscape, Reverse Portrait and Reverse Land-
scape.

Form Layout
Configure customized layout lines in the Composer, which is particularly useful
for creating DuplexPackSlip@ laser forms in eFORMz.

Lines Per Inch
The number of data lines to every vertical inch (default 6.0).

Form - Top and Left offsets
Controls the top and left starting position of a project form (values in decipoints).
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Data - Top and Left offsets
Controls the top and left starting position of a data file (values in decipoints).

Data Viewer Size

Adjusts the Data Viewer window display to match that of the form (Match page
size) or a customized view (Fixed) for data that extends beyond the form bound-
aries.

Exclude Data
When selected, the data output will be excluded from the form in display and
printed output.

Overlay on Previous Form
Form overlay. When selected, the form will be placed on top of the previous form
in the Project Tree.

Paper side
Sets the order of the forms when printed. Options: Next, Front, and Back.

Source Tray

(Default is Current Tray) Allows you to specify the tray from which the form will
be pulled (i.e. Tray 1, Tray 2, Tray 3, and Tray 4). Based on the escape codes for
your printer, the associated tray will need to be specified. For example, <ESC> &
1x H, where ‘X" is the value represented by the tray on the specific printer. For ex-
act escape codes pertaining to your printer, please refer to your printer manual.

Output Tray

(Default is Current Tray) Allows you to specify the tray the form will reside in after
being printed. Based on the escape codes for your printer, the associated number
will need to be specified. For exact escape codes pertaining to your printer,
please refer to your printer manual. <ESC> & | x G where ‘X’ is the value repre-
sented by the destination tray value. Note: ‘I = lower case ‘L.

Suppress output when empty
When selected, empty and/or blank pages are not printed. Default is unchecked.
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Font Tab
f Form Properties ﬂ‘
(General rFont r Data Suppression r Zebra XML r HTML Output r_ 3
Input Character Set

Output Character Set |150-8859-1 u Chars perinch (10.00

[ Bold [ italic Text Calor

Edit condition | OK | ‘ Cancel

Character Set
(Default is Roman 8) All numbers, letters, and symbols associated with a given
coding system.

Font
(Default is Courier) Collection of letters, numbers, and symbols that share a dis-
tinctive appearance.

Chars per inch
Sets the number of characters per inch horizontally. Used in conjunction with
fixed fonts.

Height
Vertical size of a character. Used in conjunction with proportional fonts.

Bold
Changes character(s) to appear heavy with a dark typeface.

Italic
Changes character(s) to appear with a slant upward and to the right.
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Menus and Project Properties

Text Color
Output data color when printed.

Data Relocation Tab
r Form Properties §1
General Font Data Relocation |/ Data Suppression |/ Zebra XML |/ 3

~Data Relocation Regions
Left=499.0, Top = 1281.6, Width = 1141.6, Height = 116.2 —= Left = 0.0|

1] i | IC

MNew H Edit H Remove H Disable

Edit condition OK | ‘ Cancel

Data Relocation is the relocation of incoming data based on coordinate values. In
the Input Data Viewer, the input data that is moved will be shown by a box with a
green arrow. This data will be moved to appear in the specified coordinate location
in the Form and Data Viewer.

Cross-Reference: For more information on relocating data, view the following
tutorial: http://support.minisoft.com/index.php/data-relocation]
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Data Suppression Tab
[ Form Properties u1
[ General | Font | DataRelocation |  Data Suppression | ZebraXML [ |+

~Data Suppression Region
Left =4348.5 Top = 820.8, Width = 785.2, Height = 346.6

MNew H Edit ‘ ‘ Remove H Disable

Edit condition OK | ‘ Cancel

Incoming data can be suppresed based on coordinate values. Data within these regions
will no longer appear in your Form and Data Viewer. Data suppression regions will
appear as an outline with a red *X" in the Input Data Viewer. To add a suppression region,
define the coordinate values from the Data Suppression tab in the Form Properties, or
right click and drag the incoming data region and select Suppress input data:

Cross-Reference: For more information on suppressing data, view the following
tutorial: http://support.minisoft.com/index.php/data-suppressionf
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T
Menus and Project Properties

Zebra XML Tab
rF1:|rm Properties §1

( General r Font r Data Relocation |/ Data Suppression r Zebra XML 3

Format Filelabel ol |

Jobname|labels |

Duplicates |0

|| Edit condition oK H Cancel

S Pl

The Zebra XML tab allows you to generate output in Zebra XML format to send to a
Zebra XML supported printer.

When the output file from eFORMz is sent to the Zebra printer it uses the Format File
name as the reference to which template file to use within the printer (similar to macros
in a laser printer). Create the label design using Zebra’s XML Designer software and
transfer the label design to the printer prior to printing. From the eFORMz project file
create the xml tagged values that are referenced in the Zebra template file. Jobname is
a unique name assigned to the output and Duplicates is the number of copies to print.
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HTML Output Tab
rFDrm Properties u1
Data Suppression | Zebra XML | HTML Output | TestData | q

HTML template file |C:\MinisofteFORMz_6\Projects\Order_Confir | .. |

Title|0rderConﬂrmati0n |

Subsitution delimiter | |

Output inline styles

Edit condition OK | ‘ Cancel

The HTML Output tab references an external HTML file as a template for project
creation. It is used exclusively with eDIRECT PLUS.

[

d

Cross-Reference: For more information on referencing an external HTML file,
view the following tutorial:

http://support.minisoft.com/index.php/referencing-external-html-files]
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Menus and Project Properties

Test DataTab
[ Form Properties M1
Data Suppression | Zebra XML | HTML Output | TestData 1

-

EMailAddress |te st@minisoft.co m| |

OrderMumber | |

ShipAddresslines | |

aw| |

Description | |

ﬂmount| | -
< ] ]

Edit condition OK | ‘ Cancel
i

. —

The Test Data tab allows the user to specify a constant value to act as sample data for a
given variable.

Cross-Reference: For more information on using test data, view the following
tutorial: http://support.minisoft.com/index.php/test-dataf
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Variables

Variable Types

Positional Data Block Variables

From the eFORMz Input Data Viewer, select a string of characters (left click + drag),
right click and select Add Variable.

H Viewer =
12000 | B simdatadat] = 1/ 1476.0 : 990.0

" HINTEOTT, TH - o o 1

524 by o —— SRS
SNOHCMISH, W, Add Pre-condition Procedure =
PH. 800-6382— AddPostcondition Procedure »

- FAX 360-568- rddrue »

Move input data..

Suppress input data...

Grid...
02/01/00 5343432112]carvarante.

[«]

‘.‘ e . . | L .ip|

Ir\.l'ariable u
Name |Variable1 |

Haorizontal position (0.0 Vertical position (0.0
# of characters [0 Height (0.0 -

[¥] Keep spacing *0 =Form line height
Repeat 1 | time(s) Increment line by|1
[] Copy original data to output []Include variable in XML output

[] Use as a bookmark in PDF output

| oK || Cancel ‘
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Attributes of positional data block variables:

Name
Variable name as displayed in the project layout.

Horizontal Position, Vertical Position
The variable’s starting location in decipoints (180 decipoints = 1/4 inch).

# of characters
The number of characters included in a Variable.

Height

Variable height. The selectable area is on a fixed grid, which can mean you select more
text than you intend. Adjust this setting to change the height of the selected area to select
only the intended text.

*o=Form line height

Sets the line height to the default of the form.

Keep Spacing

When checked, eFORMz inserts spaces in the variable value. This occurs when things on
the same line are positioned by a cursor command other than spaces, and there is empty
space between them. When Keep spacing is unchecked, no spaces are inserted in the
empty space.

Repeat
The number of data lines a variable is iterated..

Increment line by
Enables the skipping of lines. A value of one (1) applies a rule or runction to every line
selected, a value of two (2) applies a rule or function to every other line, and so on.

Copy original data to output

(Default is unchecked) When checked leaves the selected characters in their original
position in the eFORMz Viewer. If unchecked, the variable is not on the output without a
specific rule or placement within a document template..

Include Variable in XML output

For use with eDIRECT when checked, default unchecked. Variable names cannot include
special characters such as !, @, $, &, * when this option is selected. This selection option
only pertains to projects configured using the ‘old’ eDIRECT Wizard method of generating
output.

Use as a bookmark in PDF output
When you create PDF output, a bookmark is created where the variable is used..
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Node Data Block Variables

This variable type is used with Extensible Markup Language (XML) data. The value of

the variable comes from the location of the data n

ode in relation to parent or child

elements in the data node tree. From the eFORMz Input Data Viewer, select the node,

right click and select Add Variable.

2 Viewe

Mview =] [€1 OpenData

& [&[r2oon (R 4]

ORDERGONFIRM_ 11| = [ (=

1220:00

T OrdarCanfirmation
[Jf EMailaddess = janes mith

B 002 0 RSB
[F Subjectiine = Crder Number WO0210:

[IF EMailDearTo = Daar MRS. JAME SMITH Add Variable & Pre-candition Frocedura »

E% g:: ::”ﬂ: ;;a":;n_wa;?;;ﬂ EW AT VarTianle & Postconamion Pracedure P
B = s Addd Varianle & Rule '

o [T shipaddressLines
o= IF QrdarLing Add Rule R
o= [ QrdarLine
o= [IF Qrdarling Add Variables
Editvariae..

EE TotalProduct = 73 20
of. " -

MD

COMPANY

londay - Fricay g2

«

o

[»]

Il I
[[«]e]pfon | u.u [4]]m]p o0 “IE'a.uuu I[1000

o=
il =15 100
Biank |
r Al
Variable =

Name|CountryCode

Data Node|Data.rCoumryCode

Transfer method |Normal (any child elements as array)

Text processing|None |v|
Node Filter| |
Match Filter | |

Match Value | |

[ Include variable in XML output
[]Use as a bookmark in PDF output

OK
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Attributes of node data block variables:

Name
Variable name as displayed in the project layout.

Data Node
The node location of the variable in relation to parent or child elements in the data
node tree.

Transfer method
There are seven options:
Normal (any child elements as array)
(Default) Will display any child elements as their own array, or indexed row of data
within the parent element.
Count of child elements
Provides a count of the child elements contained within the parent element.
Sum of child elements’ data
Calculates the sum of the child elements’s data contained within the parent
element.
Concatenation of child elements’ data
Concatenates all of the child elements’s data contained within the parent element.
Concatenation of child elements’ data (comma delimited)
Concatenates all of the child elements’s data contained within the parent element.
Each element’s value is delimited by a comma.
Concatenation of child elements’ data (new line delimited)
Concatenates all of the child elements’s data contained within the parent element.
Each element’s value is delimited by a new line.
Value of child node of a parent node
Node and all subnodes
Creates a deep copy of the desired XML subnode.

Text Processing
There are two options:
Trim
Left and right trims a string of characters.
Normalize
Trims space between strings, leaving one space between each string.

Node Filter
The node filter filters for an element’s descendants. It allows grandchildren and great
grandchildren to be parsed out.

Match Filter
Matches against the child node to retrieve the value of an XML node conditionally.



Match Value

Match value is a wildcard to match against to retrieve the value of an XML node
conditionally. When a match is found, the corresponding node value from Node Filter is
used, with the exception of Value of child node of parent node.

Include Variable in XML output
Check this if you are creating eDIRECT output to XML. The default is unchecked. If
checked, Variable names cannot include special characters such as!, @, $, *.

Use as a bookmark in PDF output
When you create PDF output, a bookmark is created where the variable is used.

For activeForms Input

Used in conjunction with activeForms, this Form Variable allows the bypass of setting
the “ID” property of a Document Template input field.

[ Variable ﬁ1

Name|FiIeType |

[ Include variable in XML output
[]Use as a bookmark in PDF output

oK | ‘ Cancel ‘

Variable options include:

Include Variable in XML output
For use with eDIRECT output. The default is unchecked. If checked, Variable names
cannot include special characters such as!, @, $, *.

Use as a bookmark in PDF output
Variable will be bookmarked for PDF file output.
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Queue Monitor Variable

This Form Variable is used to retrieve data from a specified queue. The data node name
is inferred from the Variable name i.e.: “"Parameters/<Variablename>"

“<root>/QMVariables/<Variablename>"

r Bl
Variable ﬂ

Name|0rderDate |

[ Include variable in XML output

[]Use as a bookmark in PDF output

OK | ‘ Cancel ‘

L

Variable options include:

Include Variable in XML output

For use with eDIRECT output. The default is unchecked. If checked, Variable names
cannot include special characters such as!, @, $, *.

Use as a bookmark in PDF output
Variable will be bookmarked for PDF file output.

For Parameter Variable

Parameter Variable >

Mame |Variab|e'1

Type |Input only =

[] Include variable in XML output

[1Use as a bookmark in PDF output

| OK | ‘ Cancel

Variable options include:

Type
Input only, Output only, Input/Output.

Include Variable in XML output
For use with eDIRECT output. The default is unchecked. If checked, Variable names
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cannot include special characters such as!, @, $, *.

eFORMz Composer Data Customization

Use as a bookmark in PDF output

Variable will be bookmarked for PDF file output.

Global Variables

A Global Variable is a Project-level Variable. It is capable of capturing and applying
text and/or numeric values from one page across multiple pages of output. The Global
Variable can be populated with a form Variable and/or add customized Function. To
add a Global Variable to a project, right click the Project name and select Add Global

Variable:
& Project - XMLSample - o |
= XMLSan= | = |
& [ Pag| Properties... »
¥ E?_ Display Forms and Data...
¢ | Open DataFile...
Print...
Output...
Process wieDIRECT PLUS
Add Page... T
Add Global Variable...
Add Preprocessor »

Add AND Condition... 4

Row: -FROM & TO

e eY
N

Row: - TOTALS

Row: - SPACER ROW

Row: - ITEMS HEADER
Row: - ITEMS DETAILS ||
Row: - SPACER ROW

{]

[ 1+

[]

Project L eDIRECT PLUS
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The Global Variable dialog box appears. Enter the global Variable name and then enter
the number of lines the global Variable will need to repeat.

)
Global Variable - =3

Name |GlobalVariable

RepeatD time(s)

[ ] Pass lastvalue to Queue Monitor

| OK | ‘ Cancel ‘

Cross-Reference: For more information on Global Variables, view the following
tutorial: http://support.minisoft.com/index.php/global-variables/

System Variables

System Variables are dynamic and implemented at runtime. System Variables can be
added using Procedures and Functions. After a Variable has been created use a Set
Value to implement a System Variable:

r L] Bl
Set Value M
Value:
i Constant
@ Variable
——sample_statementvariables—— | -
- System variables-—-- el
MIA Il
Page Number E:| “
Current Date (Short)
Current Date (Medium) i
Current Date (Long) I:I
—_CurrentDay of Week (Mumeric) |
Current Day of Week (Short) || Cancel
I T 1 =

Available system Variables:
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System Variables

N/A Inserts an empty string

Page Number Example: xx

Current Date (Short) Example: mm/dd/yy

Current Date (Medium) Example: mmm dd, yyyy

Current Date (Long) Example: m...m dd, yyyy

Current Day of Week (Numeric) Sunday =1, Tuesday =3

Current Day of Week (Short) Example: Mon, Tue, Wed, Thu, Fri, Sat, Sun

Current Day of Week (Long) Example: Monday, Tuesday, Wednesday, etc...

Current Day of Month Example: dd

Current Month (Numeric) Example: mm

Current Month (Short) Example: mmm

Current Month (Long) Example: m...m

Current Year Example: yyyy

Current Time (Short) Example: hh:mm am\pm

Current Time (Medium) Example: hh:mm:ss am\pm

Current Time (Long) Example: hh:mm:ss am\pm timezone

Current Hour (24) Example: hh

Current Hour (12) Example: hh

Current Minute Example: mm

Current Second Example: ss

Current Millisecond Example: mm

AM/PM Example AM or PM

TimeZone (Short) Example: PDT

TimeZone (Long) Example: Pacific Daylight Time

TimeZone (RFC 822) GMT representation

Current Time (Timestamp) Returns the current time as the number of milliseconds since
1/1/1970

Data File Name Incoming data file name, for example: stmdata.dat

Full Data File Name Incoming data file name including data file path, for

example: path....\stmdata.dat

Data File Timestamp Returns the data files last modified time as the number of
milliseconds since 1/1/1970

true Sets the value to “true”.
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Current Repeat Index When an array variable in a procedure is going through its
list, the pointer into the list (the index) it is currently using
is repeated

Raw Page Data Contains all the data from the input page concatenated
together. The Variable contents are not calculated unless
they are actually used

Variable Functions

eFORMz supports the following standard Variable Functions:

Concatenate

Insert String

SetValue

Substring

Replace

Choose one of

Set Value from a Declared Constant
Set Value from a Keyed Declared Constant
Translate

Parse Date

Right Trim

Left Trim

Uppercase

Lowercase

URL Encoder

URL Decoder

UPC-EAN Check Digit

Table Lookup

SQL Lookup

Does File Exist

® & 6 6 6 O O O O O O O O O O O O o o o



eFORMz supports the following advanced Variable Functions:

eVS Barcode Data Generator
SmartLabel Barcode Data Generator
Bulk Concatenate

Base64 Decode

Base64 Encode

Regex Replace

Modulo

HashSHA1

String Length

String Position

String to HEX

HEXto String

XML to JSON

JSON to XML

Load From File

Write To File

Rename to Unique

Number to Dollars

Split String

Weighted Check Digit

Even Odd Check Digit

Decrypt

NetSuite XML Passport Generator
NetSuite XML Passport TBA Generator

® & & & 6 O O O O O O O O O O O O O O O O o oo o



Standard Functions
Concatenate

Concatenate allows the user to combine two or more character strings to make one:

r

Cross-Reference: For more information on Concatenate, view the following
tutorial: jhttp://support.minisoft.com/index.php/concatenatd

Insert String

Insert a String will insert a certain number of characters into a Variable in one of two
ways:
¢ Place and insert a string of characters in a specified position.

¢ Insert astring of characters attached to an existing string of data from the
incoming data file.

| Cross-Reference: For more information on Insert String, view the following
tutorial: http://support.minisoft.com/index.php/insert-string)

Set Value

AVariable can be set to a particular value (Constant, Variable, Image from Project &
Image from File). The newly set value will override any preceding Function or value
being picked up by the Variable.

| Cross-Reference: For more information on Set Value, view the following
tutorial: http://support.minisoft.com/index.php/set-value|
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Substring

Substring extracts a string of characters from an incoming data file or a custom-built
Variable.

| Cross-Reference: For more information on Substring, view the following
tutorial: http://support.minisoft.com/index.php/substring]

Replace

Replace a character or string of characters with another:

Cross-Reference: For more information on Replace, view the following tutorial:
http://support.minisoft.com/index.php/replace-functionj

Choose One Of

The Choose One Of Function can be used to choose a specific occurrence from an
occurring Variable by index or by matching against a parallel occurring Variable.

Cross-Reference: For more information on Choose One Of, view the following
tutorial: http://support.minisoft.com/index.php/choose-one-of/

Set Value from a Declared Constant

A Declared Constant from an eFORMzCfg_User.xml file provides the value for this
Variable Function. The form of a declaration is:

<Constant Name="OrderNbr">
<I[CDATA[Order Number]]>
</Constant>
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If this Function is used in a number of Projects to refer to the same Declared Constant,
when the Declared Constant must change, only the eFORMzCfg_User.xml file needs to
be modified, not each Project.

Note: Changes to the eFORMzCfg.xml will get overwritten as this file is updated
| or overwritten on upgrades and installs.

Cross-Reference: For more information on using Set Value from a Declared
Constant, view the following tutorial: http://support.minisoft.com/index.php/
set-value-from-a-declared-constant/

Set Value from a Keyed Declared Constant

A Keyed Declared Constant from an eFORMzCfg_User.xml file provides the value for
this Variable Function. The form of a declaration is:

<KeyedConstant Name="OrderNbrLabels">
<Entry Key="EN">
<I[CDATA[Order Number]]>
</Entry>
<Entry Key="FR">
<I[CDATA[French Order Number]]>
</Entry>
</KeyedConstant>

If this Function is used in a number of Projects to refer to the same Keyed Declared
Constant, when the Keyed Declared Constant must change, only the eFORMzCfg_User.
xml file needs to be modified, not each Project.

' Note: Changes to the eFORMzCfg.xml will get overwritten as this file is updated
| or overwritten on upgrades and installs.

Cross-Reference: For more information on using Set Value from a Keyed
Declared Constant, view the following tutorial: http://support.minisoft.com/
index.php/set-value-from-a-keyed-declared-constant/
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Translate

The Translate Function uses a dictionary of values set in a declared constant
(Translation Provider) from an eFORMzCfg_User.xml file to automatically update a
value based upon a conditional flag in a project.

i ~
Translate [ﬂ
Provider InvoiceProvider [~]

Dictionary

® Constant (' Variable
sP |

OK | ‘ Cancel ‘

L

The form of a declaration is:

<Translator Name="InvoiceProvider” Class="com.minisoft.efzUtils. XMLFileTranslationProvider”
FileName="C:\Minisoft\eFORMz_6\Projects\Dictionaries.xml"/>

Cross-Reference: For more information on using Translate, view the following tutorial:
http://support.minisoft.com/index.php/using-the-eformz-translation-file-editor-video-only|

Parse Date

The Parse Date Function parses text representing a date/time into a timestamp
(number of ms since 1/1/1970). The “"Date format” field specifies the format of the

text. It is described in detail here: docs.oracle.com/javase/6/docs/api/java/text/
SimpleDateFormat.html

Cross-Reference: For more information on using Parse Date, view the following
tutorial: http://support.minisoft.com/index.php/parse-date-function/
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Right and Left Trim

Trim extra blank spaces from the right or left of a Variable using the Right and Left Trim
Functions. To implement a trim:

, Cross-Reference: For more information on Right and Left Trim, view the following tutorial: ‘
http://support.minisoft.com/index.php/right-left-trim/

Lowercase and Uppercase

The Lowercase Function makes all text characters in a Variable lowercase, while the
Uppercase Function makes all text characters in a Variable uppercase.

Cross-Reference: For more information on Lowercase and Uppercase, view the following
tutorial: http://support.minisoft.com/index.php/uppercase-lowercase/

URL Encoder

URL encoding converts the characters of a URL into a format that can be transmitted
over the Internet. This is often used in conjunction with the Call a Web Service
Procedure.

URL Decoder

URL Decoder decodes a string that has been URL-encoded. This is often used in
conjunction with the Call a Web Service Procedure.


http://support.minisoft.com/index.php/right-left-trim/
http://support.minisoft.com/index.php/uppercase-lowercase/

UPC-EAN Check Digit

If the data for a UPC-A, UPC-E, EAN8 or an EAN13 barcode doesn’t have a check digit, it
can be calculated with the UPC-EAN Check Digit Function:

( Cross-Reference: For more information on UPC-EAN Check Digit, view the
following tutorial: http://support.minisoft.com/index.php/upc-ean-check-digit/

Table Lookup

Table Lookup is a simple way to get one value from a row of a relational database. If you
require multiple values, use SQL Lookup.

( Cross-Reference: For more information on Table Lookup, view the following
tutorial: http://support.minisoft.com/index.php/eformz-table-lookup/

SQL Lookup

The purpose of an SQL Lookup is to return additional data to an eFORMz project
based upon a value in a data file. Normally this value is an indexed item to a table in a
database.

Cross-Reference: For more information on SQL Lookup, view the following
tutorial: http://support.minisoft.com/index.php/sql-lookup/
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http://support.minisoft.com/index.php/eformz-table-lookup/
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Does File Exist

Add this Function to a Variable to determine whether a given file exists or does not
exist.

' Cross-Reference: For more information on determining if a file exists, view the following
tutorial: http://support.minisoft.com/index.php/does-file-exist/

Advanced Functions
eVS Barcode Data Generator

The Electronic Verification System (eVS), also know as the USPS PRS barcode, allows
high-volume package mailers and package consolidators to document and pay postage,
including special service fees, using electronic manifest files. The files are transmitted
over the Internet to a Postal Service™ database. eVS is designed to make it easy for
high-volume package mailers to take advantage of destination entry rates.

, Cross-Reference: For more information on EVS, view the following reference:
http://support.minisoft.com/index.php/evs-barcode-data-generator/

SmartLabel Design and Barcode

SmartLabelis an intelligent pre-paid, pre-addressed return-shipping label integrated
onto the order summary and shipped with the consumer’s merchandise. SmartLabel’s
dynamic bar code links the package to the customer’s original order and provides
returns information links vital to both the customer and the retailer.

/ Cross-Reference: For more information on SmartLabel, view the following
reference: http://support.minisoft.com/index.php/evs-barcode-data-generator/
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Bulk Concatenate

Bulk concatenation refers to the ability to search large sections of text or to display
specified text in a string format.

Cross-Reference: For more information on Bulk Concatenate, view the following tutorial:
http://support.minisoft.com/index.php/bulk-concatenatgq

Base64 Decode

Baseb4 encodes binary data by treating it numerically and translating it into a base 64
representation. To decode data in a base 64 representation, use Base64 Decode.

Base64 Encode

Base64 encodes binary data by treating it numerically and translating it into a base 64
representation. To encode data in a base 64 representation, use Base64 Encode.

Regex Replace

The Regex Replace Function in eFORMz allows you to search and replace parsed data in
the eFORMz Composer using regular expressions.

Cross-Reference: To learn more about regular expressions, consult the following entry on
the Minisoft Support Wiki: http://support.minisoft.com/index.php/reqular-expressions-2J

Cross-Reference: For more information on Regex Replace, view the following tutorial:
http://support.minisoft.com/index.php/regex-replace-video-onlyj
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Modulo

Use the Modulo Function to find the remainder after division of one number by another.

Cross-Reference: For more information on using Modulo, view the tutorial:
http://support.minisoft.com/index.php/modulo-video-only|

HashSHA1

SHA-1 (secure hash algorithm), is a cryptographic hash Function commonly used in
security applications and protocols.

String Length

String Length determines the total length of a Variable’s string of characters.

String Position

String Position determines the first occurrence of a character or a string of characters in
a string.

String to HEX

String to Hex converts a string into hexadecimal characters.


http://support.minisoft.com/index.php/modulo-video-only/
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HEX to String

Hex to String converts a hexadecimal value into a string.

XML to JSON

XML to JSON converts data from XML format to JSON format.

Cross -Reference: For an implementation of XML to JSON, view the following
tutorial: https://www.minisoft.com/support/index.php/processing-json-data-in-

eformz-projects/

JSON to XML

JSON to XML converts data from JSON format to XML format.

Load from File

Using Load from File, a variable from a value in a file can be loaded. The file can be a
constant name or a variable name.

/ Cross-Reference: For an implementation of Load from File, view the following tutorials:
http://support.minisoft.com/index.php/set-a-variable-from-file-content-with-load-from-file/
http://support.minisoft.com/index.php/web-service-post-call-output/
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Write to File

Using Write to File, a constant value or a variable value can be written to a file. One
popular use would be to write in the output data from an eFORMz project that a web
service calls.

Cross-Reference: For an implementation of Write to File, view the following tutorial: http://
support.minisoft.com/index.php/web-service-post-call-output/

Rename to Unique

Rename to Unique renames a file to a unique name. It does this by appending an
underscore and the timestamp to the end of the filename, before the file extension.

Cross-Reference: For more information on using Rename to Unique, view the
tutorial: http://support.minisoft.com/index.php/rename-to-unique/

Number to Dollars

As of eFORMz version 11.08, there is a Number to Dollars function which converts a
decimal amount to a textual amount. There are two formats. The “"Decimal Cents”
currency type consists of the following syntax: written dollar amount + “dollars” +
“and” + decimal cent amount. In this case, the value 2.22 would become “two dollars
and twenty two cents.” The other format is the “Fractional Dollars” currency type. The
syntax is: written dollar amount + “and” + fractional cent amount + “dollars.” In this
instance, 2.22 would become “two and 22/100 dollars.”

y

Cross-Reference: For more information on using Number to Dollars, view the
tutorial: http://support.minisoft.com/index.php/number-to-dollars-function/
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Split String

Split String is used for splitting a string into its substrings based on a given delimiter/
regular expression.

Cross-Reference: For more information on using Split String, view the tutorial:
http://support.minisoft.com/index.php/split-string/

Weighted Check Digit

Similar to the UPC-EAN Check Digit Function, the Weighted Check Digit Function only
differs in that it allows the user to define different weights for each number position and
define a custom modulo.

Even Odd Check Digit

Similar to the Weighted Check Digit Function, the Even Odd Check Digit Function
allows the user to define different weights for each number position, setting a custom
even weight and a custom odd weight, along with a custom modulo.

Decrypt

Decrypt is used to decrypt token data used in conjunction with NetSuite token-based
authentication.

Cross-Reference: For more information on token-based authentication, view the following
resource: https://www.minisoft.com/support/index.php/configuring-netsuite-for-token-based-
authentication
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NetSuite XML Passport Generator

Cross-Reference: For more information on NetSuite integration, view the following
resource: https://www.minisoft.com/support/index.php/netsuite-integration

NetSuite XML Passport TBA Generator

resource: https://www.minisoft.com/support/index.php/netsuite-integration/

Cross-Reference: For more information on NetSuite integration, view the following
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Procedures

eFORMz supports the following Procedures:

Calculation

Set Variable

Sum

Date Calculation

Sort

Numeric Format

Date Format

Time Interval Format

SQL Load

SQL Update

SQL End Transaction

Load Variable from a Declared Constant
Load Variable from a Keyed Declared Constant
Load Variable from a Variable
Load Variable from Project Output
Execute Project Properties
Execute a Project

XML File Load

Load Variable from XML Node
Create XML

Create JSON

Load a Component

Call aWeb Service

Call a Dynamic Service

File List

Printer List

Write to Log

Write to iSeries Data Queue

No Action
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By default, all procedures are ‘Pre-condition.’ These procedures are executed before the
form condition is evaluated. ‘Post-condition’ procedures are only executed if the form
condition evaluates to true.

Calculation

Calculation implements numeric math calculations.

Actions include:

Add

Subtract

Subtract From

Multiply

Divide by

Divide into

MOD (Integer Modulus)
DIV (Integer Divide)
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Cross-Reference: For more information on Calculation, view the following:
http://support.minisoft.com/index.php/calculation-sum-procedures/

Set Variable

Set a variable using a procedure. For example, a procedure that is running a calculation,
when completed, will place the total into another variable. Sum provides an ample
illustration.

P

Cross-Reference: For more information on Set Variable, view the following
tutorial: http://support.minisoft.com/index.php/set-variable/



http://support.minisoft.com/index.php/calculation-sum-procedures/
http://support.minisoft.com/index.php/set-variable/
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Sum

Sum adds the value of one variable to another variable.

Cross-Reference: For more information on Sum, view the following resource:
http://support.minisoft.com/index.php/calculation-sum-procedures/

\

Date Calculation

Date Calculation adds or subtracts a time interval (years, months, days, hours, minutes,
seconds) to or from a timestamp.

Cross-Reference: For more information on Date Calculation, view the tutorial:
http://support.minisoft.com/index.php/date-calculation-procedure-video-only/
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SECTION 2

Sort

Multiple sorts, in either Ascending or Descending order, can be performed on
Variable input values. The order is important as the values in the example below for
‘SortIn_Variable1’ will be sorted and placed into ‘SortOut_Variablex".

) Ascending @

["] Compare as numeric

¢ Input variables

Sortin_Variable1
Sortin_Variable2

d

Remove

Move down

rOutputvariables

SortOut_Variable1
SortOut_Variable2

d

Remove

Move down

e

| ‘ Cancel
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Numeric Format

Format a procedure to a numeric value using decimals, group separators, and currency
symbols. To implement a numeric format:

1. From the Project window select the Procedure you would like to add the numeric
format option to. Right click Action and select Numeric Format.

2. The Numeric Format dialog box displays. Specify your options and then select
OK.

Options include:

Decimal Places
Determines the location of the decimal separator in the result string.

Decimal Point Symbol
Defaultisa(.) period. Customize your decimal point using this option.

Group By Thousands
Serves as both a group separator and a number scaling specifier. As a group separator, it
inserts a localized group separator character between each group. As a number scaling
specifier, it divides a number by 1000 for each comma specified.

Thousands Symbol
Default separatoris a (, ) comma. Customize your separator using this option.

Currency and Currency Symbol
Default currency sign ( $ ). Sets the numeric value to currency. Set a custom sign in the
Currency Symbol field.

Negative Symbol and Leading negative symbol
Default symbol ( - ). Sets the numeric value to negative by adding a negative symbol. To
set the negative symbol at start of value select Leading negative symbol.

Minimum Integer Size
Placement holder for integer value.



Date

Format

Time

The Date Format feature converts a date from Epoch time (# of milliseconds since
1/1/1970). This is often used in conjunction with the Current Time (Timestamp) system
variable, which returns the current time in the number of milliseconds since January 1,
1970.

Format options include:

Short date, Medium date, Long date, Numeric day of the week, Day of the week
abbreviation, Day of the week, Day of the month, Numeric Month, Month abbreviation,
Month, Year, Short time, Medium time, Long time, Hour (24 hour format), Hour (12 hour
format), Minute, Second, Millisecond, AM/PM, Hour (24 hour format), Short timezone,
Long timezone, RFC822 timezone.

Cross-Reference: For more information on Date Format, consult the tutorial:
http://support.minisoft.com/index.php/converting-unix-time-to-other-formats/

Interval Format

The Time Interval Format feature converts a time from Epoch time (# of milliseconds
since 1/1/1970). This is often used in conjunction with the Current Time (Timestamp)
system variable, which returns the current time in the number of milliseconds since
January 1, 1970.

Format options include:

Hours:Minutes:seconds.milliseconds, Hours:minutes:seconds, Hours:minutes, Hours,
Minutes:Seconds.milliseconds, Minutes:Seconds, Minutes, Seconds.ms, Seconds,
milliseconds.


http://support.minisoft.com/index.php/converting-unix-time-to-other-formats/

SQL Load

The SQL Load feature will load variables with values from an SQL query. This is
particularly useful for returning arrays. The variables will occur the same number of
times as there are rows returned from the query.

[ Cross-Reference: For more information on SQL Load, consult the tutorial:
http://support.minisoft.com/index.php/loading-multiple-rows-with-sql-load/

SQL Update

SQL Update will return a single record from an SQL database. For returning arrays, use
SQL Load.

/ Cross-Reference: For more information on SQL Update, consult the tutorial:
http://support.minisoft.com/index.php/sql-update/

SQL End Transaction

The SQL End Transaction feature is used in conjunction with the SOL Update Procedure
to set AutoCommit to off. There are two options: commit and rollback. Commit marks
the end of a successful transaction by making all data modifications performed since
the start of the transaction a permanent part of the database. Rollback rolls back a
transaction to the beginning in order to erase all data modifications made from the
start of the transaction.
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Load Variable from a Declared Constant

This procedure loads a variable from a constant declared in the eFORMzCfg_User.xml
file. The repeat of the variable will be set to the number of values in the declaration.

Cross-Reference: For more information on using Set Value from a Declared

Constant, view the following tutorial: http://support.minisoft.com/index.php/
set-value-from-a-declared-constant/

Load Variable from a Keyed Declared
Constant

This procedure loads a variable from a keyed constant declared in the eFORMzCfg_
User.xml file.

Cross-Reference: For more information on using Set Value from a Keyed
Declared Constant, view the following tutorial: http://support.minisoft.com/
index.php/set-value-from-a-keyed-declared-constant/

Load Variable from a Variable

This procedure loads a variable with the values of another variable. The repeat of the
destination variable will be set to number of values of the source variable.

Cross-Reference: For an implementation of Load Variable from a Variable, view
the following tutorial: http://support.minisoft.com/index.php/processing-xml-
data-that-is-outside-of-xml-tags/
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Load Variable from Project Output

Load Variable from Project Output is a procedure action with a variety of potential uses,
as the following examples illustrate:

e Pass XML data to a project to transform into some other XML format.

e Given an order ID, look up the order details from a database, returning the order
information in XML format.

e Given an error code, call a subproject to convert it into an error message. This
encapsulates the details of obtaining the error message into that one project.

Cross-Reference: For more information on using Load Variable from Project

Output, view the following tutorial: http://support.minisoft.com/index.php/load-
variable-from-project-output/

Execute Project Properties

Unlike other methods of calling projects, Execute Project Procedures works in
conjunction with the “For Parameter” variable type to enable specific variables to be
passed between projects. This is particularly useful for creating multiple third-party
dropship packing lists.

Cross-Reference: For more information on using Execute Project Procedures,
view the following tutorial: http://support.minisoft.com/index.php/execute-
project-procedures/
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Execute a Project

Execute a Project is a procedure which calls another project and outputs that project to
a file, to a printer or with eDIRECT.

Cross-Reference: For more information on using Execute a Project, view the

following tutorial: http://support.minisoft.com/index.php/execute-a-project/

XML File Load

XML File Load fills one or more variables based on XML elements/attributes in a file
either with a constant or variable name.

Cross-Reference: For more information on using XML File Load, view the

following tutorial: http://support.minisoft.com/index.php/xml-file-load/

Load Variable from XML Node

This procedure is useful for loading a Variable from XML in another Variable, using
the same techniques as loading a Variable from an XML data file. This is useful when
needing information from XML data returned from a database query or web service call.

/ Cross-Reference: For more information on using Load Variable from XML Node,
view the following tutorial: http://support.minisoft.com/index.php/count-the-
number-of-lines-in-an-xml-array-variable/


http://support.minisoft.com/index.php/execute-a-project/
http://support.minisoft.com/index.php/xml-file-load/
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Create XML

The Create XML action is used to create XML data that can be passed between projects,
which is useful for Calling Sub-Projects or Returning XML from a Project. It's also similar
to Record Element in that created XML data can be sent to a file.

Cross-Reference: To implement Create XML, consult the following tutorial:

http://support.minisoft.com/index.php/create-xml/

Create JSON

The Create JSON action is used to create JSON data that can be passed between
projects, which is useful for Calling Sub-Projects or Returning JSON from a Project.

Load a Component

This procedure is useful for loading a component from a file or a URL.

’ Cross-Reference: For a use of Load a Component, consult the following tutorial: http://support.
minisoft.com/index.php/output-from-project/
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Call aWeb Service

This procedure is used for calling and retrieving data from an *http’ accessible web
service. The URL can be a constant string or a variable created earlier in the project. The
parameters are submitted with either a GET or POST request. The data can be in any
combination of URL Encoded or MIME input and output. The data returned from the
web service is parsed for return values in the form “tag=value”. The current value of the
procedure is set to the return code of the request.

[ Cross-Reference: To implement Call a Web Service, consult the following
tutorial: http://support.minisoft.com/index.php/web-service-post-call-output/

Call a Dynamic Service

This procedure is used for calling custom code running under the Dynamic Service.

File List

File List will display files from an archive.

Printer List

Printer List will display a list of printers in a variable.


http://support.minisoft.com/index.php/web-service-post-call-output/ 

Write to Log

Write to Log is a procedure which builds a complex string for logging.

Cross-Reference: To implement Write to Log, consult the following tutorial:
http://support.minisoft.com/index.php/write-to-log/

Write to iSeries Data Queue

Users can define a new Queue and access either a local or remote DTAQ. Local access
would be from a copy of eFORMz running on an iSeries host. Remote access can be
from any server type running eFORMz (Windows, Linux, iSeries, etc.) A project can now
write to a Local or Remote DTAQ.

Cross-Reference: To implement Write to iSeries Data Queue, consult the

following tutorial: https://minisoft.com/support/index.php/iseries-data-queue/

No Action

“No action” is a procedure that is useful for creating a Pre-Condition or Post-Condition
procedure that will feature a number of actions and functions inside of it. Consider that
when a complex procedure needs to be implemented, it can be challenging figuring out
which action or function will be the first to be called and selected from the popup list.
So, by selecting “No action”, the procedure is created with no contents.
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Rule Actions

Once a variable has been created a Rule Action can be implemented to transform the
look of your output and enhance its function or appearance.

Available rule actions include:

Place Text

1D Barcode
2D Barcode
Special Fonts
Load Image
Bar Chart
Gauge Chart
Page Number
Translate
Notify
Output from Project
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Cross-Reference: For information on 1D Barcodes, 2D Barcodes and
Special Fonts, consult the following: http://support.minisoft.com/index.

php/barcodes/

For more information on Bar Charts and Gauge Charts, consult the
following: http://support.minisoft.com/index.php/graphical-charting/
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Place Text Action

Use Place Text actions to put custom and system variables in a specified location on
your output. You can create Place Text actions using the following methods:
¢ Right click a variable from the Project Window and selecting Add Rule > Place Text.

¢ Direct reference, bypassing variables and directly placing a particular string of
characters. Right click data from the eFORMz Data Viewer and select Add Rule >
Place Text.

¢ Scrolling to the location in the eFORMz Form Viewer where the text should appear,
Right clicking and selecting Add Rule > Place Text.

¢ Selecting a string of characters in the eFORMz Data Viewer (left click + drag), right
clicking and selecting Add Rule > Place Text.

Page Selection
To specify what page(s) of output the Rule will display on:

Options include First Page, Last Page, nth page, Every Page, First through nth page,
nth through last page, First through nth to last page, and nth to last through last page
followed by the specified page number.

For example:

¢ “First through nth page” where nth = 5, the Rule will display on the first five pages.

¢ “nth through last page” where nth = 5, all pages except the first 4 will display the
Rule.

¢ “First through nth to last page” where nth = 5, all pages except the last 5 will display
the Rule.

¢ “nth to last through last page”, where nth = 5, the Rule will display on the last 6
pages.

Text Rotation
Options available: o, 90, 180, or 270 degrees



Text Word Wrapping

To enable line wrapping, check the Enable wordwrap box. Options available:

Line Width - Specifies the wordwrap width in decipoints (720 dec = 1in).

Line Spacing and Repeat Interval Spacing - Specifies the distance between lines. Specify
zero (0 ) if you would like to use the default form's lines per inch.

Conditional vertical increment - When set, the vertical coordinates for actions using
repeating variables only gets incremented when the action is actually executed.

Suppress blank lines - When set, it removes space in between wrapped lines. Default is
unchecked.

TIP: The Append newline feature found in the Concatenate Function
options will only work in conjunction with the Wordwrap option.

Place Text Direct Reference

Placing text can be done without the creation of variables. This method is similar to
selecting data from the Data Viewer and creating a variable, as a direct reference places
a given string of characters in a specified location of the output.

Cross-Reference: For a tutorial that utilizes placing input strings directly, view the
“Place a Barcode from Input” video here:

http://support.minisoft.com/index.php/place-a-barcode-from-input-video-only/

Load Image

Place a .jpg, .gif, .bmp, .tif, .prn, .pdf, .png, or .frm image file using the Load Image
action. Conditions can be used to allow the image to only appear when called for.
Images can be loaded in one of seven ways:

¢ Projectloads a previously saved image that was imported into the project using the
Project Properties > Images option. Images stored in the project will cause larger
project file sizes. View a tutorial here:

http://support.minisoft.com/index.php/adding-an-image-from-a-project-video-only/

¢ Project using Rule Variable loads a specified image from the Project Properties >
Images based on a variable.


http://support.minisoft.com/index.php/place-a-barcode-from-input-video-only/
http://support.minisoft.com/index.php/adding-an-image-from-a-project-video-only/

¢ Fileloads an image from a specified folder. The image will not be stored in the
project file.

¢  File using Rule Variable loads a specified image from a folder based on a specified
variable. View a tutorial here:

http://support.minisoft.com/index.php/adding-an-image-from-file-using-a-variablej

¢ PDF file loads a pdf file from a specified folder. The image will not be stored in the
project file.

¢ PDF file using the Rule Variable loads a pdf file from a folder based on a specified
variable.

¢ Component loads a .png, .jpg, .gif, .bmp, .tif or .pdf file from a composite data file.
Options include:

Desired width and height are configured in decipoints (720 decipoints = 1in). Set the
width and height for the shrink to desired size or fit to desired size options.

Scaling options include None, Shrink to desired size, Fit to desired size.

None leaves the size as is. Shrink to desired size will reduce the size of the image if it
does not fit in the desired width and height specified. Fit to desired size will change
the size of the image to match the desired width and height specified. The Lock
aspect ratio option, when true, will keep the ratio of the images dimensions the
same when scaling. This option figures which ratio (desired width / image width or
desired height /image height) is needed for scaling both dimensions of the image
to make it shrink or fit within the desired rectangle.

Cropping is enabled for images from a file. Images loaded from URLs or loaded
directly into the project cannot be cropped.

Lock aspect ratio will keep the ratio of the image dimensions when scaling.

Conditional Vertical Increment when set, the vertical coordinate for actions using
repeating variables only gets incremented when the action is actually executed.

Default resolution sets the resolution of the incoming image file.

e If the image doesn’t appear in the exact location you would like it to
appear, use your mouse to drag and drop it into position.

Load Image Based on a Condition

Cross-Reference: For various methods of conditionally placing images, view the
“Supporting Multiple Brands with eFORMz"” video here: http://support.minisoft]
kom/index.php/supporting-multiple-brands-video-only|



http://support.minisoft.com/index.php/adding-an-image-from-file-using-a-variable/
http://support.minisoft.com/index.php/supporting-multiple-brands-video-only/
http://support.minisoft.com/index.php/supporting-multiple-brands-video-only/
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Page Number

Place the page number of a form based upon the number of pages it contains or its
location within a series of pages. Options include: Page number within group, Number
of pages in group, Page number within document and Page number in document. The
Starting number sets where the page count begins.

Cross-Reference: For more information on adding page numbers, view the

following resource: http://support.minisoft.com/index.php/page-number/

Translate

To translate or convert data in a selected range.

Cross-Reference: For more information on adding page numbers, view the

following resource: http://support.minisoft.com/index.php/page-number/

Notify

Setup a rule action to notify an individual or multiple individuals via email when a
process is ran. The Notify action can be conditionally based.

Cross-Reference: For more information on adding page numbers, view the

following resource: http://support.minisoft.com/index.php/page-number/

92 Rule Actions
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Output from Project

Output from Project is used to retrieve output from a separate project, that uses an
independent data file, and include that output in the current project.

An XML (Extensible Markup Language) file with a “cdf” extension can also be used to
specify all the separate data files for a project that uses this procedure:

<?xml version="1.0" encoding="UTF-8"?7>
<CompositeData>
<Component Name="PackingSlip”>
<InputData filename="projects/\WMI/Collate/PackingSlip.scs”/>
</Component>
<Component Name="ShippingLabel”>
<InputData filename="projects/WWMI/Collate/UPS.scs” />
</Component>
<Component Name="ShippingLabel1”>
<InputData filename="projects/\WMI/Collate/Fedex1.scs” />
</Component>
</CompositeData>

When using a composite data file (.cdf), the primary component is configured on the
“Advanced” tab of the Project Properties.

Cross-Reference: For a use of the Output from Project rule, follow along with the following
tutorial: http://support.minisoft.com/index.php/output-from-project/



http://support.minisoft.com/index.php/output-from-project/

Constant Actions

Creating a Constant

eFORMz allows you to add constant values to your data output. Apply a constant value
to your form that will display on every page. To create a constant value:

1.  Right click in the eFORMz Form Viewer and select Add Constant.

TIP: If the position of the constant value needs to be adjusted simply drag
the element into position using your mouse.

The options are as follows:

¢ Image, Text, 1D Barcode, 2D Barcode, Special Fonts, Line and Box

Image

Right click in the eFORMz Form Viewer and select Add Constant > Image. The Image
Element dialog box will display. To load an image into a project, right click the project
and select Properties > Images.

Options:

Name the image element with a descriptive value (optional).
Horizontal/Vertical Position sets the constant location (in decipoints).
Desired width and height are configured in decipoints (720 decipoints = 1in).

Scaling options include None, Shrink to desired size and Fit to desired size.

None leaves the size as is. Shrink to desired size reduces the size of the image if it doesn’t
fitin the specified width and height. Fit to desired size will change the size of the image
to match the specified width and height.



Text

Cropping is enabled for images from a file. Images loaded from URLs or loaded directly
into the project cannot be cropped.

Default resolution sets the image resolution. The Lock aspect ratio option, when
checked, will keep the ratio of the image’s dimensions the same when scaling. It figures
which ratio (desired width / image width or desired height /image height) is needed

for scaling both dimensions of the image to make it shrink or fit within the desired
rectangle. Load from options include:

Project
Select an image previous loaded into the project file through the Project Properties >
Image dialog box.

File
Use the browse button to select the image you would like to add to your form as a
constant value.

PDF File
Use the browse button to select a PDF file, then in the Load Page field, specify the page
you would like to add to your form as a constant value.

Right click in the eFORMz Form Viewer and select Add Constant > Text. The Text
Element dialog box will display. Enter the text string you would like to have added to
your form as a constant value. Also, if needed, set the character alignment and font
style. Once complete, click OK.

Options:
Name enter a descriptive name for the constant value (optional).
Text enter the text string.

Horizontal/Vertical Position the constant location in decipoints (180 decipoints = 1/4
inch).

Text Color adjusts the color of the text string (Color specifications: Swatches, HSV, HSL,
RGB & CMYK).



Underline offers two styles: single solid and double solid. The thickness of the line and its
offset from the value can be configured.

Alignment rotate text 9o, 180 and 270 degrees (Default is 0). The location can be shifted
left, right or center (Default is none).

Change Font adjusts the font style.

1D Barcode

Right click in the eFORMz Form Viewer and select Add Constant > 1D Barcode. The
Barcode Element dialog box will display. Enter the characters or numeric values you
would like to barcode into the Text field. From the Barcode type drop down box select
the barcode type you would like to use. Adjust the width, height, and alignment if
needed. Once complete click OK.

Options:
Name enter a descriptive name for the constant value (optional).
Text enter the string.

Barcode Type
Types include: 30Fg, 30F9EXT, 20Fs5, CODABAR, CODE 11, CODE 128, EAN8, EAN13.
JANS, JAN13, MSI, UPCA, UPCE, POSTNET, USER-DEFINE and INTELLIGENT MAIL.

Generate Checksum when checked, generates a checksum.

Optimize barcode length optimizes the length associated with Code128 barcodes.
Trim Data when checked, trims the string.

Barcode Color adjusts the color of the barcode.

Horizontal/Vertical Position the constant location in decipoints (180 decipoints = 1/4
inch).

Width/Height default width is 10 and height is 300. Configured in decipoints (720
decipoints = 1in).

Alignment rotate barcode 90, 180 and 270 degrees (Default is 0). The orientation can be
left, right or center (Default is none).



2D Barcode

Right click in the eFORMz Form Viewer and select Add Constant > 2D Barcode. The 2D
Barcode Constant dialog box will display. Enter the characters or numeric values you
would like to barcode into the Text field. From the Barcode type drop down box select
the barcode type you would like to use. Adjust the height and alignment if needed.
Once complete click OK.

Options:
Name enter a descriptive name for the constant value (optional).
Text enter the string.

Barcode Type
Types include: MaxiCode, Aztec, Data Matrix, PDF417 and Quick Response (QR).

Horizontal/Vertical Position the constant location in decipoints (180 decipoints = 1/4
inch).

Rotation rotate barcode 9o, 180 and 270 degrees (Default is o).

Special Fonts

Right click in the eFORMz Form Viewer and select Add Constant > Special Fonts. The
Special Fonts Element dialog box will display.

Options:
Name enter a descriptive name for the constant value (optional).
Text enter the string.

Barcode Type
Types include: MICR13B, MICRCMC7, OCRA and SECURE AMOUNT.

Horizontal/Vertical Position the constant location in decipoints (180 decipoints = 1/4
inch).

Special Fonts Color adjust the color of the barcode.



Line

Alignment rotate barcode 9o, 180 and 270 degrees (Default is 0). The location can be
shifted left, right or center (Default is none).

Box

Right click in the eFORMz Form Viewer and select Add Constant > Line. The Line
Element dialog box will display. Adjust the position, length and thickness as needed. If
necessary, update the plane (horizontal or vertical) and/or the color (Default is black).
Once complete, click OK.

Options:

Name
Enter a descriptive name for the constant value (optional).

Horizontal/Vertical Position
The constant location in decipoints (180 decipoints = 1/4 inch).

Length
Adjust the length of the line (in decipoints). Default is 720 (2 inch).

Thickness
Adjust the thickness of the line (in decipoints). Default is 10.

Line Color
Adjust the color of the line.

Horizontal/Vertical
The orientation of the line.

Right click in the eFORMz Form Viewer and select Add Constant > Box. The Box Element
dialog box will display. Adjust the position, width and height as needed. If necessary,
update the border thickness and/or the border color (Default is black). To add a fill color,
check the Fill box. Update the fill color as seen fit (Default is white). Once complete,
click OK.

Options:
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Name enter a descriptive name for the constant value (optional).

Horizontal/Vertical Position the constant location in decipoints (180 decipoints = 1/4
inch).

Width adjust the width of the box (in decipoints). Default is 720 (2 inch).
Height adjust the height of the box (in decipoints). Default is 720 (2 inch).
Border Thickness adjust the thickness of the border.

Border Color adjust the color of the border.

Fill when checked, fills the box with a specified color (default unchecked).

Fill Color adjust the fill color.

Constant Values 99



Conditional Processing

eFORMz allows you to place conditions on rules and procedures. Setting a condition
on a rule/procedure determines whether or not the action associated with the rule/
procedure is processed.

eFORMz supports these logical operators:

¢ AND
¢ OR
¢ NOT

And the following data conditional operators:

Is equal to Starts with Is a number

Is not equal to Ends with Names a file that exists
Is less than Contains

Is greater than Matches

Cross-Reference: For a number of use cases, consult the following resource:
http://support.minisoft.com/index.php/eformz-conditional-logic/



http://support.minisoft.com/index.php/eformz-conditional-logic/

Document Template
Reference

Cross-Reference: For more information on the Document Template, view the
following: http://support.minisoft.com/index.php/document-template-reference



http://support.minisoft.com/index.php/document-template-reference/

Components

A Document Component is a descriptor that defines particular layout properties. There
are four Document Components: Paragraphs, Tables, Boxes and External Document
Templates.

Paragraph

To add a Paragraph, right click the form and select Add Document Component >
Paragraph.

NOTE: Paragraphs can be added to a Table. The result is to create a Row for
each line in the Paragraph.

Table

To add aTable, right click the form and select Add Document Component > Table.

Box
Right click the form, highlight Add Document Component and pick the Box option.

Elements

Document Elements are part of a Document Component. A Document Element can be
dynamic or static content, such as Text, Variables or Barcodes.



General References

Alignment

The alignment of the Paragraph. Options include Left, Centered, Right, Justified and
None (Default).

Background Color

The Automatic box, when checked, will adopt the color designated as the default color
configuration. If unchecked, the color can be altered.

Borders
Single Border

Style
The drop-down menu has Solid, Double, Dotted and Dashed options.

Thickness
Adust the thickness level in decipoints. 1 pixel is the equivalent of 7.5 decipoints. 720
decipoints is the equivalent of 1 inch.

Color
Left click the color bar to modify the border color.

Separate borders

Top style
The drop-down menu that contains style options related to the top border.

Bottom style
The drop-down menu that contains style options related to the bottom border.

Left style
The drop-down menu that contains style options related to the left border.

Right style



The drop-down menu that contains style options related to the right border.

Box Propeties (General)

Positioning

Within Document
(Default) When checked, the position is set within the document.

Absolute Positioning
When checked, the position is defined by horizontal and vertical position, by page.

Horizontal/Vertical position
Sets the horizontal and vertical positioning. Values are in decipoints.

Page

Options include First Page, Last Page, nth page, Every Page, First through nth page,
nth through last page, First through nth to last page, and nth to last through last page
followed by the specified page number.

For example:

+ “First through nth page” where nth = 5, the box will display on the first five pages.

¢ “nththrough last page” where nth = 5, all pages except the first 4 will display the
box.

¢ “First through nth to last page” where nth = 5, all pages except the last 5 will
display the box.

¢ “nthto last through last page”, where nth = 5, the box will display on the last 6
pages.

Size

Height
The Automatic option will retain the default setting for Box height. The Fixed option will
adjust the Box height to the value entered into the adjacent field.

Width

The Automatic option will retain the default setting for Box width. the Fixed option
will adjust the Box width to the value entered into the adjacent field. The Ratio option
will adjust the Box width to be at least the value entered into the adjacent field while
varying with other elements.

Background Color



The Automatic box, when checked, will adopt the color designated as the default color
configuration. If unchecked, the color can be altered by left clicking the color bar next
to the Automatic box.

Cell Properties (General)

Cell Width

The Automatic option will retain the default setting for Cell width. The Fixed option
will adjust the Cell width to the value entered into the adjacent field. The Ratio option
will adjust the Cell width to be at least the value entered into the adjacent field while
varying with other Cells.

Background Color

The Automatic box, when checked, will adopt the color designated as the default color
configuration. If unchecked, the color can be altered by left clicking the color bar next
to the Automatic box.

Vertical Alignment
Options include baseline, top, middle, and bottom.

First line indent

The indentation of the first line in decipoints. 1 pixel is the equivalent of 7.5 decipoints.
720 decipoints is the equivalent of 1 inch.

Font

The Font field contains the following options:

Automatic
(Default checked) Applies the default text configuration.

Character Set
Applies the selected character set from the drop-down menu for text values.

Font
Applies the selected font from the drop-down menu for text values.

Chars per inch
Specifies the characters per inch of the text values.



Height
Specifies the height of the text values.

Bold
When checked, the text values are bolded.

Italic
When checked, the text values are italicized.

Text Color
The Automatic box, when checked, will adopt the color designated as the default color
configuration. If unchecked, the color can be altered.

Margins
Automatic Margins

(Default) When checked, the configured settings will be implemented. When
unchecked, individual Margins can be modified.

Top
Defines the top space between a border and other outer elements.

Left

Defines the left space between a border and other outer elements.

Bottom
Defines the bottom space between a border and other outer elements.

Right
Defines the right space between a border and other outer elements.

Padding

Automatic Padding
(Default) When checked, the configured settings will be implemented. When
unchecked, Padding can be modified.

Top
Defines the top space between border and element content.

Left
Defines the left space between border and element content.



Bottom
Defines the bottom space between border and element content.

Right
Defines the right space between border and element content.

NOTE: When elements need space between them, it is better to use Margins.
When an inner element, such as text, needs space between the parent
element and itself, utilization of Padding is advised.

Row Properties (General)

Use as

Normal row
(Default checked) The Row is to be used in its declared position in the table.

Page header
When checked, acts as the first Row on the page when a table is split because of
pagination.

Page footer
When checked, acts as the last Row on the page when a table is split because of
pagination.

Repeat using

No repeat
(Default) This setting will not repeat any instance of a Row in relation to a specified
Variable or Constant value.

Constant
When checked, any instance of a Row will repeat in accordance with the given Constant
value.

Repeat of variable
When checked, any instance of a Row will repeat in relation to the given Variable value.

Row Height

The Automatic option will retain the default setting for Row height. The Fixed option
will adjust the Row height to the value entered into the adjacent field. The Minimum
option will adjust the Row height to be at least the value entered into the adjacent field.
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Background Color

The Automatic box, when checked, will adopt the color designated as the default color
configuration. If unchecked, the color can be altered by left clicking the color bar next
to the Automatic box.

108 Document Template
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Command File Processor

Script Example

java -jar Run.jar - com.minisoft.HostTools.Local.eFORMz -d c:\Minisoft\eFORMz_6\input -f
*.dat:rename -p project.efz -t PrinterA

Parameters

In this example, the java executable is assumed to be in the path of the dos shell. The
printer name is PrinterA as defined in the Printers.xml file. The project file (project.efz)
is in the current directory.

-v Log to stdout

-l <filename> Log to new <filename>

-a <filename> Append log to <filename>

-g <number> Log priority fence

-d <directory> Specify input directory

-f <filename[:disposition>] Specify file selection and optionally
disposition

-p <project> Specify project

-t <printer> Print (Black and White PCL)

-tc <printer> Print (Color PCL)

-tp <printer> Print (Postscript)

-o <filename> Output to file

-u <basefilename> Output to file with unique name

-e <basedirectory> Process with eDIRECT

-x <command> Execute external command after output

-c <directory>;<filemask>;<copy to directory> Copy files after output
-r <directory>;<filemask> Delete files after output
-n <directory>;<filemask>;<printer> Print files after output

-help



Preprocessor Data Parsing Control Codes

\b backspace

\t tab

\n linefeed

\r carriage return

\f formfeed

\\ backward slash

\a<3 decimal digits> character represented by its decimal value (000-255)

\x<2 hexadecimal digits>  character represented by its hexadecimal value ( oo - ff)

eSUBMIT Command Processing

Overview

This utility of eFORMz permits host-independent redirection of application data. Origi-
nally designed to simply write data destined for standard output device to unique file
names in a local directory for processing by the eFORMz local queue monitor.

While still accomplishing the original goal, eSubmit has been expanded to handle a
variety of file redirection tasks independent of host operating system or third party
subsystems.

Details

For parameters with characters that may be handled by the host command processor
(such as semicolons on UNIX, use double quotes around the parameter value:

java -jar jars/eSubmit.jar -lpr “FILEPRINT; TITLEA;Iphost”



Commands

File Name (-f)

Specify file selection and optionally disposition. Optional dispositions include: rename
and delete

Example: -f “inv.data:rename”

Output Directory (-d)
Specify input directory.

Example: -d “/minisoft/salesorders”

MQ Queue (-mq)
This option directs the data to an IBM© MQ Queue on a remote system.

Message Queue Format (-mgm)

Specify message format.

Secure FTP (-rd)

This option has five parameters; remote directory, host, port, user name, password.

Use the File Name (-f) option to set the file name mask.

Project (-p)
Specify project file.

Example: -p "sampinv.efz”



LPR (-lpr)

Send data to an LPD service. Three required parameters.
The first parameter is the queue name on the remote host.

The second parameter is used in the naming of the file on the receiving host. Use it to
direct the queue monitor in what project to use. The title can also be used in defining
which output device eFORMz will use.

The fourth parameter, used to define the port to connect to, is optional.

Secure LPR (-slp)

Send data securely to an LPD service. Eight required parameters.
The first parameter is the queue name on the remote host.

The second parameter is used in the naming of the file on the receiving host. Use it to
direct the queue monitor in what project to use. The title can also be used in defining
which output device eFORMz will use.

The fourth parameter, used to define the port to connect.

PCL Print, Black and White (-t)
PCL Print, Color (-tc)

Printer name.

Example: -t “LJgsi” or -tc “LJ3800DN”

Output to File (-0)
Output to file. Output file extension options include: .pdf, .prn, .pcl, .xml.

Example: -o "inv.pdf”



Output to unique file name (-u)

Output to file with unique names. Output file extension options include: .pdf, .prn, .pcl,
xml.

Example: -u "inv_.pdf”

Process with eDirect (-e)

Process with eDirect. The base directory will be the directory the eDirect output will be
sent to.

Example: -e “/minisoft/invoice/output”

Process with eDirectPlus (-ep)

Process with eDirectPlus. The base directory will be the directory the eDirectPlus out-
put will be sent to.

Example: -ep “/minisoft/invoice/output”

Execute external command after output (-x)

Execute external command after output. Command options: mv - move command

Example: -x “mv /minisoft/input/*.hld /minisoft/backup”

Copy files after output (-c)
Copy files after output.

Example: -c “/minisoft/input/*.hld /minisoft/backup”

Delete files after output (-r)
Delete files after output.

Example: -r “/minisoft/input/*.hld"”



Print files after output (-n)
Print files after output.

Example: -n “/minisoft/output/*.prn roadrunner”

Static input file (-i)

This option is used to read from a fixed file in place of the standard input device. It is
useful to simulate input during testing.

Log file location and name ()

This option has two required parameters, the directory in which to create log files and
the file mask used to create log files.

Example: -1 “/minisoft/log;eformzlog.txt”

Verbose tracing (-v)

Use this option at the direction of Minisoft support to identify configuration issues.

Timeout in seconds (-w)
While reading stdin (or a static file) time to wait for data or EOF.

Execute after data is copied (-exe)

It will launch a local queue monitor to execute against the copied file using the configu-
ration set by the other arguments or configuration file.

So if you used the arguments:
-d <directory> -f<file> -p<project> -t <printer>

eSubmit would copy the stdin to a unique file in <directory> and execute a queue moni-
tor to execute a project against that file to print to <printer>



If you used the arguments:
<igname> -exe

eSubmit would use the settings in the configuration file for <igname> to copy the file
and execute a queue monitor to process the file using those same settings, except the
file selection will be set to the destination file name.

eFORMz is needed with a valid license.

Configuration (-cfg)

Use configuration file. Defaults to eSubmit.cfg. The configuration is based upon the
monitor object and read looking for a matching InputQueue. The queue name to match
is the parameter if only one bare (without a leading hyphen) parameter is supplied.

If there is not a single bare parameter, an attempt will be made to locate a blank (no
characters) queue name.

Help (-help)

Display utility parameter usage.

Quick Reference Guide

-f <filemask[:disposition]> Specify file name

-d <directory> Specify output directory

-mq <host>;<port>;<channel>;<queue Specify MQ queue

manager>;<message queue>

-mqm <file format> Specify message format

-rd <remote directory>;<host>;<port>;<user>,<pa  Specify remote (SFtp) output directory
ssword>

-p <project> Specify project

-Ipr <queue>;<title>;<host>[;<port>] Send data to an LPD service
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-slp <queue>;<title>;<lpd host>;<Ipd port>;<ssh ho
st>;<sshport>;<user>;<password>

Send data to an LPD Service via SSL

-t <printer>

Print (Black and White PCL)

-tc <printer>

Print (Color PCL)

-tp <printer>

Print (Postscript)

-o <filename>

Output to file

-u <basefilename>

Output to file with unique name

-e <basedirectory>

Process with eDIRECT

-ep <basedirectory>

Process with eDirectPlus

-x <command>

Execute external command after output




-c <directory>;<filemask>;<directory> Copy files after output

-r <directory>;<filemask> Delete files after output

-n <directory>;<filemask>;<printer> Print files after output

-i <filename> Specify static input file (in place of stdin)

-l <directory:filemask> Specify logfile location and name

v Verbose (stdout) tracing

-w <number> Time in seconds to wait for more data
(default 30)

-exe Execute after the data is copied

-cfg Configuration filename (defaults to eSub-
mit.cfq)

-help

User Configuration Files

Site specific configuration files available:

eFORMzCfg_User.xml
FontSpecs_User.xml

The above files are not installed with an eFORMz installation to insure that the files are
never overwritten. Files with the above naming convention should be placed in the fol-
lowing directory:

C:\Minisoft\eFORMz_6\



Custom Form Sizes
Site specific custom form sizes can be added to the eFORMzCfg_User.xml, for example:
<PageDimension Name="B6” PCLNumber="1" PortraitA="5250" PortraitB="7560" PortraitC="4860"
PortraitD="7560" PortraitE="180" PortraitF="0" PortraitG="120" PortraitH="360" LandscapeA="7560"

LandscapeB="5250" LandscapeC="7272" LandscapeD="5250" LandscapeE="144" LandScapeF="0"
LandscapeG="120" LandscapeH="360" />

Contact Minisoft (support@minisoft.com) for custom form sizes.

Cross-Reference: For more information on adding a custom form or label size,
view the following tutorial:

http://support.minisoft.com/index.php/custom-form-and-label-sizes)

Preprocessors and External Functions

Place preprocessors and/or external function references in the following file:
eFORMzCfg_User.xml

Minisoft will provide a user with the custom file reference and external files needed, for
example:

<?xml version="1.0" encoding="UTF-8"?>

<eFORMzConfiguration>

<Preprocessor Name="Macro Insert” Class="com.sample.MacrolnsertPreprocessor” [>

<ExternalFunction Name="eVS Barcode Data Generator”
Class="com.minisoft.ExternalFunctions.eVSBarcodeDataGenerator” >

</eFORMzConfiguration>


http://support.minisoft.com/index.php/custom-form-and-label-sizes/

Font Configuration

Site-specific font configurations can be placed in a file referred as follows:
FontSpecs_User.xml
Example:

<?xml version="1.0" encoding="UTF-8"?>
<Fonts>
<Font Name="Arial Black” PCLTypeface="-1" Spacing="Proportional”
PitchFactor="0.008332330903266" ViewerFont="Arial Black” PDFFont="fonts/ariblk.ttf">
<Style Style="4" Factor=".66667" [>
<Style Style="5" Factor=".66667" BaseStyle="1" [>
<Style Style="8" Factor=".5" [>
<Style Style="24" Factor="1.5" />
</Font>
<RTFInputFonts>
<Font InputName="Arial Black” FontName="Arial Black” />
</RTFInputFonts>
</Fonts>

Cross-Reference: For more information on adding a font to eFORMz, view the
following tutorial:

http://support.minisoft.com/index.php/adding-a-font-to-eformz|



http://support.minisoft.com/index.php/adding-a-font-to-eformz/

Database URL and Driver
Classes



Supported URL and Driver Classes

DB2 (iSeries)

Database name:
Connection name. Actual database name not needed in this field.

Driver Class:
com.ibm.as400.access.AS400JDBCDriver

URL:
jdbc:as400://123.456.78.90

Add the following properties and their values:
user
password
databasename

If you do not know the database name, logon to your AS/400 and run WRKRDBDIRE
from the command line. Only the database marked *LOCAL is the local database that
resides on the AS/400 system.

Image and Eloquence

Database name:
Connection name. Actual database name not needed in this field.

Driver Class:
com.minisoft.jdbc.MSJDBCDriver

URL:

Write access:
jdbc:MSIDBC://[?Server=xxx.xxx.xx.xxx&ServerPort=30007&User=xxx&UserPassword=
xxx&Group=xxx&Account=xxx&lmageDatabaseo=eformz,WRITE,0,1,0

Read access:
jdbc:MSIDBC://[?Server=xxx.xxx.xx.xxx&ServerPort=30007&User=xxx&UserPassword=
xxx&Group=xxx&Account=xxx&lmageDatabaseo=eformz,READALL,0,5,0

Note: Requires Minisoft's JDBC (Java Database Connectivity) driver.
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Database URL & Driver Classes

Informix

Driver Class:
com.informix.jdbc.IfxDriver
URL:

jdbc:informix-sqli://<IP address of host machine>:<port no>/<database>:
INFORMIXSERVER=<server_name>;user=<user_name>;password=<password>

Example:

jdbc:informix-sqli://Sturgeon:9o88/stores_demo:
INFORMIXSERVER=informix_server;user=admin;password=xxx

Microsoft Access

Driver Class:
net.ucanaccess.jdbc.UcanaccessDriver
URL/Connection String:
jdbc:ucanaccess://[database name]
JAR Files:

From your UCanAccess installation folder copy the following files into the C:\
Minisoft\eFORMz_6\jars\Local\folder:

ucanaccess-X.X.X jar
commons-lang-X.X.jar
commons-logging-X.X.X jar
hsqldb.jar
jackcess-X.X.X jar

More information for Connection String Properties: http://ucanaccess.sourceforge.net/
site.html#examples

Download Link: http://ucanaccess.sourceforge.net/site.html#home



http://ucanaccess.sourceforge.net/site.html#examples
http://ucanaccess.sourceforge.net/site.html#examples
http://ucanaccess.sourceforge.net/site.html#home 

MySQL
Driver Class:

com.mysql.jdbc.Driver

URL:
jdbc:mysql://[host name or ip address]/[database name]?user=[user
name]&password=[user password]

jdbc:mysql://123.456.78.90/eformz?user=eformz&password=eformz

Note: When referencing the database URL address in the web.xml file, the user name
and password values can be excluded. For example:

jdbc:mysql://123.456.78.90/eformz

You must copy your MySQL jdbc driver class into your eFORMz jar folder for eFORMz
to connect to your MySQL database.

Copy:
\sq|Driver\mysgl-connector-java-xxxx\mysql-connector-java-xxxxx-bin.jar

to the following directory:
C:\Minisoft\eFORMz_6\jars\Local

Oracle

Driver Class:
oracle.jdbc.driver.OracleDriver

URL:
jdbc:oracle:thin:[user]/[password]@[hostname or ip address]:[Listener Port]:
[SID — Database Name]

Example:
jdbc:oracle:thin:@123.456.78.90:1521:emaildb

Note: In order for eFORMz to connect to your Oracle database, you will need to copy
your oracle jdbc driver class into your eFORMz jar folder:



Copy:
[Oracle_Home]\jdbc\lib\classesXXX.zip

to the following directory:
C:\Minisoft\eFORMz_6\jars\Local

and then rename the classesXXX.zip to classesXXX.jar

Oracle Cluster
JDBC URL for Oracle RAC ( Real Application Cluster)
jdbc:oracle:thin:[user]/[password]@(DESCRIPTION=(LOAD_BALANCE=0n)
(ADDRESS=(PROTOCOL=TCP)(HOST=host1) (PORT=1521))

(ADDRESS=(PROTOCOL=TCP)(HOST=host2) (PORT=1521))
(CONNECT_DATA=(SERVICE_NAME=service)))

Progress
Driver Class:
com.ddtek.jdbc.openedge.OpenEdgeDriver

URL:
jdbc:datadirect:openedge://servername:10005;databaseName=c:\progressdb\
sportstest;user=username;password=password;defaultschema=pub

JAR Files:

From your Progress installation folder copy the following files into the C:\Minisoft\
eFORMz_6\jars\Local\ folder:



base.jar
openedge.jar
util.jar

SQL Server

Driver Class:
com.microsoft.sqlserver.jdbc.SQLServerDriver

URL:
jdbc:sqlserver:/[12.34.567.899:1433;databaseName=ECOMVER;
user=minisoft;password=minisoft2007;selectMethod=cursor;
parametersAsUnicode=false

Note, you will need to specify the correct IP address, port (if different), database name,
user, and password.

Sybase

Driver Class:
com.sybase.jdbc3.jdbc.SybDriver

URL:
jdbc:sybase:Tds:localhost: 2638

Parameters:

SERVICENAME=demo
HOSTNAME-=localhost



user=DBA

password=sql

STREAM_CACHE_SIZE=10000
LITERAL_PARAMS=false

CURSOR_ROWS=0

SESSION_TIMEOUT=300
JCONNECT_VERSION=6

CANCEL_ALL=true

DYNAMIC_PREPARE=true
LANGUAGE_CURSOR-=false
SEND_LONG_PARAMS_REGARDLESS_OF_CAPABILITIES=false
IGNORE_DONE_IN_PROC=false
REQUEST_HA_SESSION=false
ELIMINATE_o10SM=true
GET_BY_NAME_USES_COLUMN_LABEL=false
ESCAPE_PROCESSING_DEFAULT=false

JAR File:
Place the Sybase jar file into the C:\Minisoft\eFORMz_6\Local\ folder:

jeconns.jar



OnDemand Print Utility



E—
OnDemand Print Utility

OnDemand Print

The OnDemand Print utility, which is included with Minisoft eFORMz, lets you enter
data as a value through a keyboard entry or a scanner. It also includes an option to use
a browse button to select files from specific folders. There are two sections within this
utility. One is to rename the extension of a print file, which is often used for the later
capture and processing of the a print file by the eFORMz print monitor. The other is to
simply select and print a file.

Rename Print File

)

Find: .prn
Rename Copy: .EXt

Hold: .hld

Enter or browse for the file to rename

File To Print

Available Printers
HF LaserJet 55i

Delete the Print File [[]

Enter or browse for the file to print

INI File
c\Minisoft\e FORMz_&eFORMzPrint ini

The .ini file, eEFORMzPrint.ini, lets you configure the project directory path, a specific
find extension, a renamed extension and an extension for files that have already been
processed. The default processed file extension is .hld.



For example, if a match is found this utility renames the .prn extension to .rdy or .dat.
The eFORMz Local Director Toolkit can then be modified to look for .rdy or .dat files.

After the eFORMz Director selects and processes these files, it changes the extension
back to .hld (hold).

eFORMZzPrint.ini

[eFORMzPrint Options]

;DirectoryPath: Path to the print files to be renamed

;FindExtension: File extension of the file to be renamed

;CopyExtension: File extension of the renamed file

;HoldExtension: File extension of already processed print files

;BrowseOnlyFind: o=false 1=true. When set to o all files are displayed when browsing
; and hold files can be reprinted.

; When set to 1 only files with the find extension are

; displayed when browsing and only files with the find

; extension will be printed - no reprinting of hold files.

DirectoryPath=c:\
FindExtension=.prn
CopyExtension = .rdy
HoldExtension=.hld
BrowseOnlyFind=0
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